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Exercicio1

0S PRIMEIROS PASS0S EM SISTEMAS
DE INFORMACAO GEOGRAFICA - QGIS

Objetivos

Este exercicio pretende introduzir os conceitos e ferramentas basicas dos
SIG, utilizando a aplicagdo para desktop QGIS, versdo 2.16.0-Nedebo.

Inclui-se a visualizac@o e exploragdo de dados espaciais.

E ainda abordado o conceito de camada e efetuada a exploracdo de informa-
cdo espacial sobreposta, edi¢do de simbologia em funcdo de atributos e ge-
racdo de mapas (apresentagdo em “layout”).

As diferentes versdes do QGIS poderao ter funcionalidades diferentes. Pelo
gue se recomenda a utilizagdo da versdo 2.16.0-Ngdebo pelos utilizadores
menos experientes.

A. ABRIR E EXPLORARUMPROJETO QGIS

1. Abraum projeto QGIS vazio e adicione uma camada.

(1 |
Carregue no botdo Windows =" e digite QGIS. Na lista Apps Results for “qgis”
de programas apresentada selecione QGIS Desktop. Faca
OK nas dicas do QGIS e escolha abrir um projeto novo. | QGIS Deskiop

2160

QGIS Browser

QGIS Desktop
2.16.0 with GRASS..

1.1 Adicione a shapefile “Limites_politicos.shp”.



1.1.1 Clique no botdo com o simbolo (Adicionar Camada Vetorial), navegando

até a pasta que contém os dados do exercicio. Adicione a shapefile
Limites_politicos.shp. (em alternativa pode entrar em Camada » Adicionar
Camada » Adicionar Camada Vetorial).

Projecto  Editar Ver |Camada | Configuracdes Mddulos Vector Raster BasedeDados Web Processamento  Ajuda
= Criar Camada 4
| v |

& 7 =2

", Adicionar Camada Vetorial. .. Ctrl+5hift+
.ﬂ Adicionar Camada Raster... Ctrl4shift+R

Adicionar Camada

Incorporar Camadas e Grupos. ..

As acdes em QGIS (assim como em outras aplicacdes SIG) tém
0 habitualmente mais do que um caminho para chegar ao mesmo fim.

Nestes exercicios serdo utilizados, por defeito, os botbes rapidos, por
serem 0s mais simples de utilizar.

O projeto QGIS aberto apresenta agora uma camada de dados designada por
Limites_politicos, que representa os limites politicos a escala mundial (fonte original ESRI
com edig&o IH).

Um projeto QGIS inclui varios setores (Figura 1), dos quais se destacam:

a. abarra de menus e ferramentas;

b. o painel de pesquisar, que permite aceder aos ficheiros e pastas onde estdo os
documentos;

c. o0 painel das camadas, que apresenta e gere a visualizacdo das diferentes camadas
de dados incluidas no projeto;

d. avista do mapa;

e. abarra de estado, que inclui as coordenadas, que variam em fung&o da posi¢ao do
cursor sobre o mapa.

T
FROE s[Be g ADPRG50&!]
I VA LN 5

(Gorse )

Figura 1 — Projeto QGIS e principais setores.



1.2 Grave o0 projeto na pasta de

tl’aba|h0. ’m‘ Editar Ver Camada Configuragies M
" Novo Ctrl+n
Abrir... Ctrl+0
1.2.1 Clique em Guardar ou Guardar Nove a partir de modelo g
L. Abrir Recente +
Como = &4 navegando ate a pasta
gue contém os dados do exercicio. [ Guardar Come... Cirl+Shift+5
Grave o projeto com O nome g Guardar como Imagem. ..

Exportar como DXF..

“AE_Ex1”. (Poderd, em alternativa, ir
— /| Propriedades do Projecto. .. Cirl +5hift +P

a Projeto » Guardar ou Guardar 4 : =
¢} Movo Compositor de Impressdo Cirl+P

CO m 0) . ‘?“ Gestor de compaositor...
Compositores de Impressao 4
[©) sair do QIS ctrl+Q
A aplicacdo QGIS permite configurar ¥ configure os atainos 7 %
atalhos para as tarefas mais hcsio ntaho -

Adicionar a partir do Ficheiro de Definigdes da Camada. ..

frequentemente utilizadas, bastando O Adiiore i

E‘?, Adicionar ao Enguadramento

para iSSO ir a Conﬁguragées > 9., Adicionar Camada de Texto Delimitao. ..

Configurar atalhos e selecionar a |2 s canedecisacaivssoL. crsshi
A ) % Adicionar Camada Espacial Oradle. .. Ctrl+5hift+0

ferramenta pretendida, de seguida o %, Aconar Camada PostGIS. cul+0
~ . 'u Adicionar Camada Raster... Ctrl+shift+R
botdo Mudar e depOIS carregar nas #7 Adicionar Camada Spatialite... Cirl4shift+L
‘\f; Adicionar Camada vetorial... Ctrl+shift+v

teclas que se pretende utilizar como @ Aciconar Comada WCS. .

7 Adidonar Camada WFS...

atal h 0. §®1 Adicionar Camada WMSAUMTS Ctrl+shift+ hd
Mudar Desmarcar Marcar como padrdo (Nenhum)
A carregar... Salvar...

2. Explore as diferentes ferramentas de pesquisa e visualizagao de dados
disponiveis nas barras de ferramentas Navegacdo de Mapas e
Atributos.

2.1 Com a ferramenta Identificar Elementos verifique que tipo de
informacao é disponibilizada para diferentes paises (Figura 2).

s Idenficer Resuliades

' o |Elemenho |\|'alor |
‘ﬂ (=) Limites_paliticos
' =l OBJECTID_1 175
(Derivado)
[ (Agbes)

OBJECTID_1 175
CBJECTID 175

- COUNTRY Portugal
-~ Shape_Leng 55.97955816120
& “area_km2 91634, 79953540000
L ]
4

o

Figura 2 — Informacgao associada a fungao “Identificar Elementos”.



3. Verifique a informacdo disponivel na tabela de atributos da camada
Limites_politicos, carregando com o BLDR! sobre a camada
Limites_politicos e de seguida em Abrir Tabela de Atributos.

A tabela de atributos que abriu inclui a base de dados, de natureza ndo espacial, associada
a camada Limites politicos. Cada um dos registos (ou linhas) desta tabela representa um
pais (ou estado) caracterizado geograficamente pela sua posicdo no mapa e que inclui,
entre outros, 0 nome do pais e a informacédo da sua area (Figura 3).

JE Limites_politicos :: Features total: 247, filtered: 247, selected: 0 — =
4] m| € L T E & 0 S B | »

OBJECTID_i | OBJECTID | COUNTRY | Shapeleng | areakm2 |4
1 1| Afghanistan 59.19387784520 | 642064.4720530...

2 2| Albania 1284975873360 | 28747.96401330...
3 3| Algeria 75.85276613630 | 2316111.243499 ...
& 4| American Samoa 1.77328426121| 209,11235704300
5 5| Andorra 1.19944298713 | 459.26308154600
[} 6| Angola 73.41581293600 | 1251834.116639...

7 7| Anguilla 0.97019560247

33.29831140540 @
[ T Mostrar todos os elementos El:]

Figura 3 — Tabela de atributos.

3.1 Explore a tabela de atributos através das ferramentas de pesquisa e
exploracéo disponibilizadas na barra de ferramentas da tabela de atributos.

3.1.1 Quais os paises com maior e com menor area?

Clicando no cabecalho de cada uma das colunas da tabela é possivel ordenar os dados de
forma crescente ou decrescente (numérica ou alfabeticamente).

3.1.2 Qual a area dos paises Madagascar e Sérvia?

Utilize a ferramenta de pesquisa Select/Filter T (atencdo que a descricdo dos paises
estd em inglés, respetivamente Madagascar e Serbia). Em alternativa utilize o Filtro de
campos do menu de filtros do canto inferior esquerdo.

A ferramenta * permite visualizar no mapa o elemento escolhido (aproximando a regiao
em que o mesmo se insere). Os dois botdes no canto inferior direito permitem alternar entre
a vista da tabela e a vista dos filtros.

1 BLDR — Bot&o do Lado Direito do Rato



oy Calculadora de campo ?

Ativando o modo de edigéo [:] passam a

% Apenas actualizar 4 elementos seleccionado

% Criar um p Atualizar campo existente-

estar disponiveis os botdes Novo campo v camp
Nome do campo de saida _— -
e Apagar Cam po __l s que permitem Crlar e Tipo de campo de saida N\Jmeruinte\ruﬂnteiro) : =
. . ~ . Qutput field length 10 - Predsdo 0 =
eliminar campos ou colunas. O botdo Abrir gmmm
calculadora de campos “# permite criar I IEEWONY - [remes frtedey
novos campos, associados a expressoes Cade d x>
.. oy Campos e Valores
definidas pelo utilizador. o
2 Dot e hors
Fuzzy Matching
Geometria
Geral
Matematica
Operadores
G (D) |5 e

Pré-visualizacio da saida:

oK Cancelar Ajuda

3.1.3 Qual a latitudes e longitude aproximada do centro do Uruguai e do centro da
Jordania? (Uruguay e Jordan em terminologia Inglesa).

Para obter rapidamente informacédo sobre a latitude e longitude de qualquer pais, podera,
por exemplo, colocar o cursor sobre o pais e visualizar as coordenadas mostradas no canto
inferior esquerdo.

Para conseguir encontrar 0os paises rapidamente poderd fazer uma pesquisa com a

ferramenta & (Selecionar por expressédo), escolhendo Campos e Valores »
COUNTRY, fazendo BLDR para carregar todos os valores da tabela e em seguida
digitando o nome do pais desejado no campo “Valores” (Figura 4).

Para fazer aparecer a expresséo na respetiva janela, clique duas vezes sobre “COUNTRY”
na lista de Campos e Valores, seguido do operador “=" e clicando duas vezes sobre o pais
desejado nos resultados da janela da direita (Valores). Note que a conjuncéo a utilizar
neste caso € “or’, para que a aplicagdo utilize a conjungcdo matematica “ou” (se
utilizassemos a conjungao “and”, a aplicagao iria procurar um pais cujo nome satisfizesse
simultaneamente a condicdo de ser igual a Uruguay e Jordan, devolvendo um resultado
nulo).

£ | Selecdionar |+

No final clicar em Selecionar
fundo da Figura 4).

(veja os dois paises selecionados na imagem de



? Select by expression - Limites_politicos

Expressdo Editor de Funcies

58 |3 | I [ || srupo Field 2l -
"COUNTRY" = 'Uruguay' or "COUNTRY" = 'Jordan’ > Aggregates A | | Double click to add field name to expression string.
> Cadeia de texto Right-Click on field name to open context menu sample
v Campos e Valores | value oading options,
OBJECTID_1 Valores ‘jord a
MNULL
OBJECTID ‘Jordan’
COUNTRY
Shape_Leng
area_km2
< > » Condicionais r 1 0
s iC = w | Carregar valores |todos os valores Gnicos| | 10 amostras |
Pré-visualizag3o da saida: 0 -
& Selecdonar |V| Fechar J

Figura 4 — Ferramenta de seleg&o por expresséo.

4. Selecado de dados através da area de visualizagéo.

4.1 Faga Zoom na Europa e selecione com a ferramenta Selecionar

Elementos &7 alguns paises do sul da Europa (Figura 5).

;0es Modulos Vector Raster BasedeDados Web Processamento Ajuda

é@%ﬁﬁ}‘fﬂ@p}a@@ﬂe %Q'EH@'%Z v

@ %BV- 4/ BRG B *

S]]
o0
(Y]

|5 Selecionar elementos por poligono
I Selecionar elementos por delimitacdo livre
(1 Selecionar elementos por raio

Figura 5 — Ferramentas de selecdo através da area de visualizagao.

4.1.1 Abra a Tabela de Atributos e verifique as op¢des de selecdo (Figura 6).



55,979558 16120

0 Mostrar elementos seleconados
T Mostrar Slementas Visfveiz no Mana
T Mostrar slementos editados & noves

Fiitra de campos v
T Fitra Avangada (expressac)

Figura 6 — Opgdes de selecdo na tabela de atributos.

4.1.2 Utilizando os botdes do canto inferior direito alterne entre a vista de
tabela e a vista de formulario.

4.2 Feche a Tabela de Atributos.

B. ADICIONARNOVAS CAMADAS

5. Adicione a shapefile que inclui as zonas biol6gicas no Atlantico
Europeu.

5.1 Cligue no simbolo , havegando até a pasta que contém os dados do
exercicio. Adicione a shapefile atlantic_biological_zones.shp.

5.1.1 Explore espacialmente a informagéo incluida na camada adicionada, utilize a

ferramenta Identificar Elementos Qk e verifiqgue os contetdos da tabela de
atributos.

C. EDITARSIMBOLOGIA

6. Modifique a aparéncia das diferentes camadas: Limites_politicos e
atlantic_biological_zones.

10



6.1 Para editar a simbologia faca duplo clique na camada Limites_politicos,
abrindo assim a caixa de propriedades desta camada. Carregue na aba
Estilo e de seguida em Fill, escolhendo o tipo de preenchimento que
pretende para a camada selecionada (Figura 7).

6.1.1 Altere a simbologia dos paises, para um padréo que lhe pareca adequado.

Este tipo de edicdo de simbologia aplica-se a todas as entidades contidas na camada.

= Um simbolo

=[] Fl
i . Preenchimento simples
€7 Etiquetas

ESE Campos
®|[=]2][a][a][¥]

Tipo da camada do simbolo

Preencher
Preenchimento transparente
Cutline S S

Preenchimento simples

|
Estilo de preenchimento
7 etadados Estilo de contorno
Variaveis Estilo da unido
Legenda w Renderizacio da ca

Transparéncia da camada

‘Blending mode' para camag

etk oI R
Desenhar efeitos | ] H H N [

Copiar cor

Control feature renderi
Colar cor

Recolher cor

=5 Escolher cor...

Figura 7 — Campo de edicéo de simbologia na caixa de propriedades de uma camada.

6.2 Edite a  simbologia ~da  camada & Umsmbaolo

atlantic_biological_zones em funcdo do Sem simbolos

contetido da tabela de atributos. Abra a caixa = U sirhoke

de propriedades deste tema, e na aba Estilo Categorizado

substitua  “Um  simbolo” &  por & Graduado

“Categorizado” = = Baseado em regras
B} roiigonos invertidos
& 25D

11



6.2.1 Altere a simbologia das diferentes zonas biolégicas em funcédo do campo Name
(em Coluna), escolhendo a Escala de Cor e carregando em Classificar para
aparecerem todos os elementos da coluna Name da tabela de atributos (Figura

E Categorizado -
Coluna abe NAME -
Simbaolo [] atterar...
Escala de cor I l BrBG hd Editar Inverter
Simbola | Valor | Legenda
% Abyssal Abyssal
® Circalittoral Circalittoral
® Deep Circalittoral ~ Deep Circalittoral
x Infralittoral Infralittoral
® Lower bathyal Lower bathyal
® Mid bathyal Mid bathyal
® Upper bathyal Upper bathyal
® Upper slope Upper slope
»
Classificar g | | = Excluir tudo Avancado ~
W Renderizagdo da camada
Transparéncia da camada O 0 :
‘Blending mode' para camadas MNormal b4
‘Blending mode' para elementos Mormal -
Desenhar efeitos E]
Control feature rendering order
Estle = Cancelar Aplicar Ajuda

Figura 8 - Campo de edi¢do de simbologia, em func&o de um atributo, na caixa de propriedades de uma camada.

As escalas de cor também podem ser editadas -,;
(no botdo Editar), abrindo a janela Gradiente Pre—

H Bl |
de escal_a de cor, assim como cada uma das
classes individualmente (clicando duas vezes e——

H 1 i : I
no re_spetwo S|mbf)lo, 0 que abre a janela L —
Selecionador de simbolos. i 2

Ao contrario da edicao de simbologia aplicada no ponto anterior, aqui a atribuicdo de um
padrdo depende de informacgdo qualitativa descrita na tabela de atributos da camada (ou
tema), i.e. depende dos proprios atributos de natureza qualitativa.
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Se, por outro lado, pretender
atribuir um padréo em fungéo de
atributos quantitativos, devera
utilizar a opcdo Graduado em
vez de Categorizado,
escolhendo a coluna com dados
numeéricos que quer representar
(Figura 9).

Painel de cores |j I [source]

4 | ‘ Editar ‘ [] tnverter

-
Simbolo Valores Legenda
. 0.57 - 147634.57 1-147835
. 147634.57 - 401721.59 147635 - 401722
D 401721.59 - 67862145 401722 - 678621
D 67B8621.45 - 985877.85 678621 - 985878
D 985877.85 - 1297195.48 985878 - 1297195
D 1297195.48 - 1955991.69 1297195 - 1955992
D 1955931.69 - 3154969.80 1955932 - 3154970
D 3154969.80 - 8505356.41 3154970 - 8505356
. 8505356.41 - 12423359.26 8505356 - 12423359
. 12423359.26 - 16806257.19 12423359 - 16806257

Figura 9 - Exemplo de edi¢do de simbologia em fungéo de uma caracteristica numérica (area de cada pais).

D. EXPLORACAOQ ESPACIAL DE INFORMACAO

7. Adicione os temas de natureza vetorial
OSPARHabitats2015points_PUBLIC.shp,

disponibilizadas

EMODNET - European Marine Observation and Data Network.

Broadscale_map.shp e

pela

7.1 Descarregue a informacdo através do sitio de internet da EMODNET
(http://www.emodnet-seabedhabitats.eu/), em Access Data » Data

download » Select Layer(s) to download.

7.1.1 Descarregue os dados com a designacéo “OSPAR threatened and/or declining
habitats 2015” e “Predicted broad-scale EUNIS habitats - Atlantic area”.

Podera verificar os termos e condi¢des de uso destes dados através da hiperligagéo (visivel
na pagina de downloads): EMODnet Seabed Habitats webGIS Terms & Conditions.

7.2 Descomprima os ficheiros descarregados e adicione-os a pasta do

exercicio.

Se tiver dificuldade na pesquisa ou a descarregar os ficheiros, utilize os disponibilizados
na subpasta EMODNET, na pasta de dados deste exercicio.

13


http://www.emodnet-seabedhabitats.eu/
http://www.emodnet-seabedhabitats.eu/PDF/EMODnet_Seabed_Habitats_webGIS_Terms_&_Conditions_and_Privacy_Policy_(WEB).pdf

7.3 Verifigue o modelo de dados de cada um dos temas adicionados.
Esta informacao é facilmente deduzida pela aparéncia que cada uma das camadas tem no
Painel das Camadas.

8. Edite a simbologia do tema Broadscale_map em fun¢do do substrato e
remova o0 contorno que aparece no respetivo padréo.

. Selecionador de simbolos ?
8.1 Para remover o contorno do padréo basta S

escolher Alterar em Simbolo (ap0s .
categorizar e classificar a simbologia, = =
escolhendo a coluna Substrate), abrindo o U —— :
Selecionador de simbolos. No —
Preenchimento simples do Fill, escolher SanlE Rl
Limite transparente no Outline.

9. Edite a simbologia dos habitats OSPAR em funcao do tipo de habitat.
Faca uma simbologia que seja particularmente distinta para os montes
submarinos (Seamounts).

10.Explore a informacéo espacial das diversas camadas sobrepostas.

10.1 Verifigue qual o habitat, qual o substrato e qual a zona biol6gica que
caracterizam a posicéo Lat: 39.378, Long: -31.884 (coordenadas em graus
decimais).

Utilize as ferramentas = (Identificar elementos)ou ¢ (Dicas de mapa). A ferramenta
Identificar elementos abre uma nova janela com as informacdes da tabela de atributos
acerca do elemento que foi selecionado. A ferramenta Dicas de mapa necessita de ser
configurado previamente, no separador Mostrar da janela de Propriedades da Camada,
onde se escolhe qual o campo da Tabela de Atributos a mostrar aquando da passagem
do cursor sobre cada elemento do mapa que queremos explorar.

10.2 Selecione o campo Country para mostrar nas dicas de mapa e teste a
ferramenta.

E. GERAR MAPA (COMPOSICAQ DE IMPRESSAOQ)

11.Crie uma imagem com a informacao espacial dos montes submarinos
e zonas biogeogréaficas (ou, em alternativa, montes submarinos e
substrato), incluindo legenda com a descricdo das diferentes

14



simbologias, escala grafica e seta de indicacdo de Norte. Tome como
exemplo a Figura 10.

11.1 Amplie uma area restrita para representar, por exemplo, as proximidades
de um grupo de ilhas do Arquipélago dos Acores (Grupo Ocidental, Grupo
Central ou Grupo Oriental), ou a faixa litoral de Portugal Continental.

11.2 Carregue no simbolo 3 (Novo Compositor de Impressao), que o
direciona para a pagina de construcao do esquema de péagina, e atribua-
lhe um nome (por exemplo “Montes1”).

29.000°W 28.000°W 27.000°W 26.000°W 25.000°W 24.000°W

Legenda
OSPARHabitats2015_points_PUBLIC atlantic_biological_zones
A Seamounts I Abyssal
Limites_politicos I Circalittoral
o { B 1- 147635 B Deep Circalittoral
RN i B Infralittoral

[ Lower bathyal

I Mid bathyal
Upper bathyal
Upper slope

38.000°N

37.000°N

29.000°W 28.000°W 27.000°W 26.000°W 25.000°W 24.000°W

Figura 10 — Exemplo de produto final com informag&o de natureza espacial.

11.2.1 Pode configurar a pagina no Painel de Composicao, por exemplo escolhendo a
orientacdo como Paisagem ou Retrato, definindo os tipos de grelha, etc.

11.2.2 Para incluir elementos carregue em U—_KL (Adicionar novo mapa) e desenhe um
retdngulo no interior da janela de impressdo, onde ir4 surgir 0 mapa, cuja

posicdo pode ser ajustada carregando em @ (Mover contetdo do item)
(Figura 11).
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(=5

11.2.3 Adicione elementos como a legenda o

e aescalagrafica “, alterando as suas
propriedades no painel Propriedades
do item (selecionar itens para mudar as

suas propriedades). Carregando em ?
(Filtrar a legenda pelo conteudo do
mapa) reduz-se a legenda aos
elementos constantes do mapa. A seta
de “norte” pode ser adicionada

desenhando uma seta /'}, e inserindo a

~
letra N com o botao .

Existe também a opc¢do de usar uma imagem como seta de norte - com
vantagens que se relacionam com o alinhamento automaético relativamente

ao norte cartogréfico. Ver exemplo em:

Itens | Histdrico de comandos |

Ttens
| R | g8 |]tEr|1
t 3 Legenda
X <scale bar >
% Mapa 0

Composicio Propriedades doitem | Gerador de Atlas |
Propriedadas do iam
Legenda
Quebrar o texto em
w Itens da legenda
R Actualizacdo automatica

=R

'0SPARHabitats2015_points_PUBLIC
Broadscale_map
Limites_politicos
0SPARHabitats2015 polvgons PUBLIC
atlantic_biological_zones

Abyssal

Circalittoral

Deep Circalittoral

Infralittoral

Lower bathyal

Mid bathyal

Upper bathyal

Upper slope

(v]a]&]#|=]2)=]%H

% Only show items inside current atlas feature

https://gis.stackexchange.com/questions/97464/how-to-put-north-arrow-

and-scale-on-map-in-composer-in-ggis-2-2-0

Compositor  Editar  Ver Modelo  Atias  Configurages

B RBReRELhee NAALP0 CRAAEE @ ¢ [+ 9

P LB B B B PR

¥

Ttens | Histérico de comandos
Histdrico de comandos
Maver conteddo da item

Mover contetido do item
Mover contetido do item
Mover contetido do item
Mover contelido do item
Mover conteddo do item

A [ [

ComposicSe | Propriedades doitem | Gerador de Atias |

M®

=] =

Altura [ZIU‘UU

Be

Unidades | mm

il

x: 33.7499 mm

Orientac3o | Paisagem - &L

[

v di i pagina ao

Margem de topo (mm) | 0.00

Esquerda 0.00 2 Direita 0.00 =
Fundo 0.00 =
Redimensionar pagina

W Configuracbes da pagina

~ | 1litem selecdionado

Nmero de paginas 1 &

Fundo da Pagina Alterar... g

Figura 11 — Janela de composigdo de impresséo.
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11.2.4

11.25

11.2.6

11.2.7

i

Adicione a informacdo geografica da
area de visualizacdo através da
adicao de grelhas com informacéao de
latitude e longitude (graticula). V4 ao
Painel de itens » Mapa »
Propriedades do item » Grelhas »

Adicionar nova grelha I:II':Ill':|
»Desenhar grelha e escolher as
diferentes opc¢des (como o sistema
de coordenadas ou o tipo de grelha,
o tipo de moldura, 0 espacamento
entre coordenadas, etc.).

x Mapa 0

Propriedades do item Gerador de Atlas

Propriedades do item

Composicao

Mapa 0

w Grelhas
) = r'y v

Grelha 1

w X Desenhar "Grelha 1" grelha
Tipo de grelha Sdlido -

SRC EPSG:4258

Exporte a imagem criada para um formato de imagem, SVG ou PDF em

%6 e ‘g (Figura 11). Grave com 0 nome Mapal na pasta de trabalho.

=]
Grave 0 modelo (ou template) do compositor de impresséo com o0 nome

Compositorl (com extensao .gpt).

Grave o projeto QGIS.

Em QGIS, como em muitas outras aplicagfes, deve evitar-se a utilizagdo de
espagos ou caracteres especiais nos nomes de projetos ou de ficheiros,

assim como nos caminhos (paths) de dados e projetos.

Utilize descri¢cBes alfanuméricas separadas por underscore em vez de
espagos e ndo inicie adenominagdo com um caracter alfanumérico, pois pode
originar erros.

Esta pequena “dica” previne muitos erros e falhas de processamento de
dados em QGIS, que namaior parte dos casos ocorre sem se perceber arazao.

F. VISUALIZAR DADOS NO NAVEGADOR QGIS E VISUALIZAR
METADADQS (OPCIONAL)

O Navegador QGIS é uma aplicacdo vocacionada para organizar e gerir os dados de um
projeto SIG de forma independente, permitindo ver os metadados, a pré-visualizagéo e os
atributos dos ficheiros, sem necessidade de os importar para a aplicacdo QGIS Desktop.
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O Navegador funciona como um
explorador de pastas e ficheiros
comuns (como shapefiles da ESRI
ou ficheiros Mapinfo), de bases de
dados (por exemplo, PostGIS ou
MSSQL) e de ligagbes WMS/WFS.
Permite também aceder a dados
GRASS (integracdo com SIG
GRASS).

12.Inicie o Navegador QGIS.

e : e
R Atualizar @ Gerir WMS a Nova shapefile

header Param | Metadados |

= Definir SRC da camada

Pré-visualizacio Atributos

1 Inicio
Favorites

@ Oracle

@ rostals

f Spatialite

& ArcGisFeatureServer
@ ArcGisMapServer
) ows

& wes

& wrs
@ wms

Parar a renderizacio |

|
12.1 Carregue no botdo Windows m e digite QGIS. Na lista de programas

i t} QGIS Browser
apresentada selecione QGIS Browser Bkl .

12.1.1 Navegue até a pasta de trabalho e veja a lista de ficheiros incluidos na aba

Param. Reconheca os tipos de geometria dos diferentes dados.

12.1.2 Mude para a aba Metadados e verifique as informacdes auxiliares aos dados

(Figura 12).

Figura 12 — Informagdes contidas no Navegador QGIS.

Os metadados séo informacado acerca dos dados. Normalmente apresentam
uma breve descricdo sobre o que sdo, quem os produziu e, no contexto SIG,
o sistema de coordenadas em que se encontram.
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Os metadados podem ser criados através de ferramentas informéticas para esse efeito,
como por exemplo o MIG editor, que produz metadados de informacdo geografica
baseados nas normas e requisitos vigentes, nomeadamente as normas 1SO 19115, 19119,
19139, os requisitos da Diretiva INSPIRE e o Perfil Nacional de Metadados (Perfil MIG)
(http://snig.igeo.pt).

12.1.3 Na aba Pré-visualizacao veja a pré-visualizacao de cada uma das shapefiles.

12.1.4 Na aba Atributos veja a tabela com os atributos de cada uma das shapefiles.

12.2 Navegue até a pasta de trabalho, desta vez utilizando o explorador do
Windows.

12.2.1 Verifique os ficheiros que se encontram associados a cada um dos temas que
utilizou neste exercicio.

Um ficheiro QGIS é geralmente constituido por um conjunto de ficheiros relacionados que
compreendem informacao distinta.

O formato nativo da ESRI para dados de natureza vetorial, suportado pela

o aplicacdo QGIS, é a shapefile, constituida por um ficheiro principal que
contém a sua geometria, com extensao ‘.shp’. A este ficheiro (e com o mesmo
nome) associam-se ficheiros com extensodes ‘.shx’, ‘.dbf’, e “.prj’, que incluem
informacgao auxiliar como a tabela com os atributos (em ‘.dbf’), ou o sistema
de coordenadas (em ‘.prj’).
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Exercicio 2.1

PORTUGAL NOMUNDOQ | SISTEMAS DE
COORDENADAS

Objetivos

O principal objetivo deste exercicio é determinar a drea territorial de
Portugal e a drea correspondente as dguas marinhas portuguesas,
tendo por base informacgdo geografica oficial disponibilizada pela
Dire¢do-Geral do Territério (DGT) e pelo Instituto Hidrografico (IH).

Neste exercicio ira ter acesso a informacdo referenciada em sistemas
de coordenadas distintos, pelo que realizara tarefas de transformacao
e projecao de coordenadas.

Ira, também, realizar uma série de tarefas de edicZo e processamento

de forma a simplificar, editar, corrigir e extrair a informacdo pretendida,
nomeadamente gerir e editar informacdo das tabelas de atributos, homo-
geneizar e agregar informacdo espacial ndo necessaria, fazer edicdo ve-
torial, rotular informacdo e calcular areas.

Este exercicio esta distribuido por trés etapas: uma primeira onde se
introduz a problematica dos sistemas de coordenadas (Ex. 2.1); uma
segunda etapa que aborda a gestdo de campos de tabelas de atributos
(Ex. 2.2) e, finalmente, uma terceira etapa, de edigdo vetorial (Ex. 2.3).

A. ABRIR E EXPLORAR UM PROJETO QGIS - SISTEMAS DE
COORDENADAS

1. Abraum projeto QGIS vazio.

1.1 V& a Configuracbes » OpcOes, onde ira escolher o separador SRC
(Sistema de Referéncia de Coordenadas). Verifique o Sistema de
Coordenadas (SC) em que se encontra o projeto (Figura 1).
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O QGIS utiliza o0 WGS84 como sistema de coordenadas pré-definido. No

e entanto é possivel alterar esta pré-definicdo, em “Iniciar sempre os novos
projetos com o seguinte SRC”, definindo por omissdo o SC a apresentar em
sessdes futuras.

| @ sk Personaiizado...

D q\« Gestor de estilos...
v; 'u ﬁ) '(} = @'*) Configurar Atalhos...

|"%, Personaliza3o...

Painel de Pesquisar

W SRC predefinido para novos projetos

‘{Q Sistema N3o ativar a reprojecio ‘on the fly'
) enable ‘on the fly' f layers have different CRS
B8 Origem de dados o i i
Ativar a reprojecdo 'on the fly’ por predefinicdo
/ .

& Renderizacio Iniciar sempre 0s novos projetos com o seguinte CRS

, ? +[®]
¥ Cores SRC seleccionado (EPSG:4326, WGS 84) |4J
I8 3anela e Legenda ¥ SRC para novas camadas

) Ferramentas de Q:thmdouna;\ovamadae'awda,wwdommadaémeqadaeniomsRC(SsmdeRefﬁéncade
mapas denadas,

‘ ® Prompt for CRS
Compositor
Use project CRS
tab —
B ootoier Usar um SRC padrBo | SRC seleccionado (EPSG:4326, WGS 84) |~ | =

“ GDAL

L Regido

W Transformacdes de datum padrdo
Perguntar pela transformagdo de datum quando ndo for defenido um padrdo

@)=

B Autentcacso |SRC Fonte |SRC de Destino | origem da transfon | Destino da de datum |

o ) oo | | e

Figura 1 - Painel de visualizac&o do sistema de coordenadas do projeto QGIS.
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1.1.2

~ . &, . . .
Escolhendo o botdo Seleccionar SRC € possivel visualizar os cerca de

6700 SC (g), separados em dois grupos: Sistemas de Coordenadas
Geograficas e Sistemas de Coordenadas Projetadas (também designadas
por retangulares), complementados por um terceiro separador, Sistema de
Coordenadas definido pelo utilizador. Mantenha o0 SRC WGS 84 (faca OK).

V4 a0 botdo da barra inferior & EPSG:4325 que abre a janela de Propriedades
para este projeto, no separador SRC. Faca Enable ‘on the fly’ CRS
transformation (OTF), para que as camadas a carregar sejam
automaticamente transformadas para o SRC do projeto, em modo ‘on the fly’.

2. Adicione as camadas de dados (shapefiles) “LinhaBase.shp”;
“ExtensaoPlataformaContinental.shp”; “MarTerritorial.shp”; e
“Zona_Economica_Exclusiva.shp”, fornecidas pelo Instituto
Hidrografico (IH) e disponiveis na pasta de dados.
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2.1 Abra o Navegador QGIS e navegue até a pasta que contém os dados
disponibilizados pelo IH, gravados na pasta de trabalho referente ao
Exercicio 2, na sub-pasta InstitutoHidrografico. Arraste as quatro
shapefiles para o QGIS.

Em alternativa, podera adicionar as mesmas shapefiles através do atalho Adicionar

Camada Vetorial , no QGIS Desktop.

2.2 Qual o modelo de dados de cada uma das camadas?

2.3 Qual o sistema de coordenadas em que se encontra cada uma das
camadas que adicionou?

Poder& encontrar a solucdo para estas questdes de varias formas:

No Painel das Camadas, com o botado do lado direito do rato (BLDR) sobre cada uma das
camadas carregadas e escolhendo Propriedades » separador Geral.

No Navegador QGIS, selecionando a respetiva camada (a informacdo aparece no
separador Metadados) (Figura 2).

g Atualizar @ Gerir WMs VEJ MNova shapefile .-"-r' Definir SRC da camada

header A~ | Param Metadados Pré-visualizacio Atributos
4 || AEE-1 ~

y | DirecaoGeralTerritorio Nas unidades do sistema de referéncia espacial da camada

4 | InstitutoHidrografico *Min,yMin -41.3089, 28 0992 xMax, yMax -12.2768,
[ ExtensacPlataformaContinen... 48.9976
1 LinhaBase.shp Sistema de Referéncia Espacial da Camada
.~ MarTerritorial shp
2 Zona_Economica_Exclusiva.s... +proj=longlat ~datum=1G584 «no_defs N
kdarineReninns

Figura 2 - Painel de visualizagdo dos metadados no Navegador QGIS.

Nos ficheiros associados a respetiva shapefile, abrindo o ficheiro com extensao .prj num
editor de texto (e.g. o Bloco de Notas do Windows) (Figura 3).

E ExtensaoPlataformaContinental.prj - Bloco de notas

Ficheiro Editar Formatar Ver Ajuda

GEOGCS["GCS_WGS_1984",
DATUM[ “D_WGS_1984",
SPHEROID[ “WGS_1984",6378137.0,298.257223563]],
PRIMEM[ "Greenwich",0.0],
UNIT["Degree",0.0174532925199433]]|

Figura 3 — Conteudo do ficheiro com extens&o .prj associado & shapefile ExtensaoPlataformaContinental.
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B. ADICIONAR  INFORMACAO EM  SISTEMAS  DE
COORDENADAS DIFERENTES

3. Adicione os limites administrativos de Portugal (CAOP - Carta
Administrativa Oficial de Portugal) disponibilizados pela Dire¢cao-Geral
do Territério (DGT).

3.1 Adicione as camadas com os limites administrativos de Portugal
(poligonos) que se encontram na pagina da DGT (em
http://www.dgterritorio.pt/  navegue até Cartografia e geodesia W
Cartografia » Carta Administrativa Oficial de Portugal (CAOP) »
CAOP download » Carta Administrativa Oficial de Portugal - Verséao
2016).

Em alternativa podera utilizar os ficheiros disponibilizados na pasta do Exercicio 2,
subpasta — DirecaoGeralTerritorio.

Estas camadas que iré adicionar encontram-se nos sistemas de coordenadas:
 Continente — ETRS 1989 Portugal TM06 (datum ETRS 1989; Projecéo TM);

* Regido Autbnoma dos Acores Oriental e Central - PTRA08 UTM Zone 26N (datum ITRF
1993; Projecdo UTM);

* Regido Autonoma dos Acgores Ocidental - PTRA08 UTM Zone 25N (datum ITRF 1993,
Projecdo UTM);

* Regidao Autonoma da Madeira - PTRA08 UTM Zone 28N (datum ITRF 1993; Projecdo
UTM).

3.2 Verifigue o0 SRC em cada uma das camadas ap0s 0 carregamento no
QGIS.

Todas as camadas tém um datum equivalente.

O projeto QGIS ao qual esta a adicionar as camadas esté representado no sistema de
coordenadas geograficas - WGS84 (ver ponto 1.1). Este sistema tem por base o datum
WGS84, idéntico ao datum ETRS89 (e ITRF93) (Consultar o Guia Técnico Sophia
Sistemas de Informacéao Geografica: Analise Espacial para informagao complementar).

Estamos assim a trabalhar com dados que, embora apresentem projecdes diferentes,
estdo num datum equivalente, o que significa que a uniformizagéo para um sistema unico
ocorre através de uma simples conversao (ou proje¢éo) de coordenadas.
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As transformacdes do QGIS utilizam os pardmetros predefinidos pelas
bibliotecas GDAL (Geospatial Data Abstraction Library) e PROJ.4
0 (publicados pela Open Source Geospatial Foundation), importados durante
a instalacdo do QGIS e considerados suficientes para a maioria das
utilizacdes. E, no entanto, possivel adicionar transformagdes de data “on the
fly” para Portugal Continental (consultar o blog do Grupo de Utilizadores

QGIS G ).

No caso deste exercicio as diferentes camadas tém projecdes distintas, mas como tém um
datum equivalente, as transformacgdes sugeridas (por omissdo) apresentam parametros a
zeros.

A alteracdo entre sistemas de coordenadas aqui descrita faz-se de modo “on the fly’, i.e.,
uma conversao/transformacdo em tempo real, que ndo altera as propriedades originais dos
dados (se a camada for carregada noutro projeto QGIS, ou se for observada no Navegador
QGIS, mantém o seu SC original).

C. PROJETARDADOS NUM SISTEMA DE COORDENADAS

4. Crielprojete novas shapefiles, em coordenadas geograficas WGS84,
com as camadas de dados que ndo estdo neste sistema de
coordenadas (camadas com limites administrativos).

Até agora as conversdes de coordenadas efetuadas foram temporarias (on the fly), uma
vez que nao se alteraram as propriedades dos dados originais. Para alterar as coordenadas
intrinsecamente nos dados devera exportar a shapefile, escolhendo, em SRC, o SC
desejado (Figura 4).

3 Guardar camada vetorial como...

Formato IESRI Shapefile 4 l
Salvar como lContinente—wgs I ’ Pesquisar I
SRC |Projeto CRS (EPSG:4326 - WGS 84) 5

Figura 4 — Exportar dados utilizando o sistema de coordenadas do projeto (WGS 84).

5. Remover as camadas de dados CAOP que nao se encontrem em
WGS84 e agrupe as camadas de dados em dois grupos: “Aguas
Marinhas” e “Limites Administrativos”:
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5.1 Selecione as camadas de dados relativas as zonas marinhas e com o
BLDR escolha Agrupar Selecéo.

5.2 Repita o procedimento para as camadas de dados com os limites
administrativos e nomeie os grupos (BLDR/ Renomear sobre o nome do
grupo) (Figura b).

Painel das Camadas & X
o S SRR W= g
v f'ﬁ Aguas marinhas
D ExtensaoPlataformaContinental
[Vl [___] MarTerritorial
. Zona_Economica_Exclusiva
v ﬁﬂ‘ Limites administrativos
[[] cont_aap_caop2014
¥ [I] ArqAcores_GCentral_AAd_CAOP2...
[ ArqAcores_Gocidental_AAd_CAO...
[T ArqAcores_Goriental_AAd_CAOP2...

&

Figura 5 — Agrupar camadas e renomear grupos.

6. Verifique que todas as camadas de dados do seu projeto estdo no
mesmo sistema de coordenadas.
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Exercicio 2.2

PORTUGAL NO MUNDO | TABELAS DE
ATRIBUTOS

Objetivos

O principal objetivo deste exercicio é determinar a area territorial de
Portugal e a area correspondente as aguas marinhas portuguesas,
tendo por base informacdo geografica oficial disponibilizada pela
Direcdo-Geral do Territdrio (DGT) e pelo Instituto Hidrografico (IH).

Neste exercicio ird ter acesso a informacdo referenciada em sistemas
de coordenadas distintos, pelo que realizara tarefas de transformacao
e projecao de coordenadas.

Ira, também, realizar uma série de tarefas de edic3o e processamento

de forma a simplificar, editar, corrigir e extrair a informagdo pretendida,
nomeadamente gerir e editar informacdo das tabelas de atributos, homo-
geneizar e agregar informacao espacial ndo necessaria, fazer edigdo ve-
torial, rotular informacdo e calcular areas.

Este exercicio esta distribuido por trés etapas: uma primeira onde se
introduz a problematica dos sistemas de coordenadas (Ex. 2.1); uma
segunda etapa que aborda a gestdo de campos de tabelas de atributos
(Ex. 2.2) e, finalmente, uma terceira etapa, de edi¢do vetorial (Ex. 2.3).

A. ABRIR E EXPLORAR UM PROJETO QGIS - TABELA DE
ATRIBUTOS

1. Simplifique ainformacéo databela de atributos das camadas que fazem
parte do grupo Aguas Marinhas (criado no exercicio anterior) apagando
os atributos com informacdo dispensavel para os objetivos deste
exercicio. Neste sentido, apague todos os campos, mantendo apenas,
guando exista, o campo Nation.
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Para apagar campos tem de abrir a tabela de atributos e ativar o modo de edi¢édo. Escolha
0 botdo Ativar o modo de edicdo ¥ , ficando ativas as op¢cbes Novo Campo e
Apagar Campo . Escolha esta Gltima e selecione os campos que quer apagar.

No caso da camada ExtensaoPlataformaContinental, mantenha o campo ID, uma vez que
€ 0 Unico campo existente.

Note que é possivel, sem gravar nem desligar o modo de edi¢do, alternar entre a edi¢éo
de diferentes tabelas, com a funcéo Alternar Edi¢c&o, que se obtém carregando no BLDR
sobre cada uma das camadas no Painel das Camadas.

2. Adicione um campo de texto a cada uma das tabelas de atributos que
representem areas marinhas, utilizando um nome comum, como por
exemplo “Descritivo”.

G Adicionar campo 7
.. Nome Descritivo
2.1 Adicione um novo campo nas .
A Comentario
tabelas de atributos das camadas
Tipo Texto (string) -

ExtensaoPlataformaContinental e
MarTerritorial, utilizando o botdo

MNumera inteiro (inteira)
Whole number {integer 64 bit)

Comprimento MNimero decimal (real
| Texto (string) h

Tipo de fornecedor

, garantindo que utliza o Data
mesmo nome (“Descritivo”), tipo
(Texto) e comprimento (40) em oK Cancelar

ambas as camadas.

Os campos de dados das tabelas de atributos no QGIS podem ser de diversos
tipos, em funcdo da natureza da informacdo que contém: NUmero Inteiro;
Whole number; Nimero decimal; Texto ou Data.

Nos campos adicionados inscreva o0 nome da respetiva shapefile (“Extensao da Plataforma
Continental” e “Mar Territorial”).

Poderéa fazé-lo diretamente na tabela de atributos (elemento a elemento) ou através da

abe Descritivi| «

ferramenta , escolhendo o campo a editar e, no campo em branco e entre plicas,
escrever o texto desejado, seguido de Actualizar Tudo (Figura 1).
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7 MarTerritorial :: Features total: 6, filtered: 6, select.. — O x
JREBC 20 & LTESP B R »

abcDesai v | = | & | | Mar Territorial] || Actualizar Tudo | | Actuslizar selectionados

RCID
5210
& '
@ :
3
v 4

5

area Descritivo

0.25025 Mar Territorial
5218 0.37367 Mar Territorial
5219 1,19434 Mar Territorial
5220 0.86820 Mar Territorial
5240 0.79741 Mar Territorial

5242 1.72025 Mar Territorial

<

Figura 1 — Edicdo de campos utilizando o preenchimento automéatico diretamente na tabela de atributos.

[

Y Mostrar todos os elementos,

Note, na Figura 1, o aspeto dos poligonos quando esta em modo de edigdo (cada veértice
passa a estar editavel, ficando representado por um X).

Os pontos 3.1 e 3.2 podem ser substituidos por um Unico passo, escolhendo Abrir

1:'|
Calculadora de campo Q
» Criar um novo campo,
criando diretamente nesta
janela todos os dados para o
novo campo (nome, tipo de

[] Apenas actualizar 0 elementos seleccionado

® Criar um novo campo Atualizar campo existente-
Criar campo virtual

Mome do campao de saida | Descritivo

Campo S ComprimentO), Tipo de campo de saida | Texto (string) - [I‘-JA'I'IOP-I | ']
seguido da Expressdo, onde | g seidiengts % = preasio [0 5]
se escreve, entre plicas o
simples, a expressdo a :
e A Rt | R T I 45 Pesquisa funcio de ajuda

inscrever em cada elemento

A 't
do campo (Figura 2) Utilize 'Zona Econdmica Exclusival ; :g:;g;:...ﬁ :ranrazanggrega =
este método para criar o Comad-
campo  “Descritivo”  na S
camada dl [D) |5 o @

Zona Economlca EXCIUSiva Pré-visualizacdo da saida: 'Zona Econdmica Exdusiva’ et eh
Cancelar Ajuda

Figura 2 — Edicao/criacao de campos utilizando a funcdo Calculadora de campo.

Para além da inscricdo de texto nos campos do tipo texto, a Calculadora de
campo permite, quando aplicadas a campos numéricos, efetuar diversas
operacdes matematicas, com (ou sem) interacdo dos diversos campos
numéricos que constituem a tabela de atributos.

i
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3. Adicione as tabelas de atributos das camadas dois campos onde ira
calcular, em graus decimais, as coordenadas (latitude e longitude)
correspondentes.

3.1 Que tipo de campo de dados devera escolher?

Neste caso aconselha-se a escolha de um campo do tipo Nimero decimal (real), para
incluir as casas decimais associadas as coordenadas.

3.2 Calcule o centro geométrico (latitude e longitude) para cada registo das
camadas de dados Polygon utilizando a Calculadora de campo,
escolhendo Criar um novo campo, preenchendo os dados do novo
campo e escrevendo a expressao: “x($geometry)” para retornar a longitude
do centro de cada poligono da tabela. Para a latitude cria-se outro campo
e substitui-se, na expresséo anterior, o x por y (Figura 3).

|x

O campo de pesquisa | sobre a lista das fungdes, facilita a sua procura.
Clicando sobre cada uma das fungbes € possivel ver uma breve descricdo da mesma,
assim como exemplos da sua utilizagéo.

¥ Calculadora de campo 7 b4

Apenas actualizar U elementos selecdonado

Criar um novo campo |:| Atualizar campo existente

[ Criar campo virtual

MNome do campo de saida |Longib_|de |

) = RCID
Tipo de campo de saida | Numero dedmal (real)

Output field length Precisdo

Expressdo Editor de Funcées

== EIEI A D] W] [«

X.( Sgeometry ) ¥ Aggregates # | | Returns the ® coordinate of a peint geometry, or the x-coordinate of the
max_length centroid for a non-point geometry.
maximum

¥ Cadeia de texto
regexp_replace
regexp_substr

¥ Condidionais
regexp_match

v Fuzzy Matching geom  uma geometria
soundex

¥ Geometria
convex_hull
exterior_ring * x{ geom from wkt({ "POINT(Z 5)' ) ) —2

= > extrude * PR Si ) — x coordinate of the current

x (gecm)

=, ' ;
intersects_bbox W feature's centroid

Pré-visualizacdo da saida: -15.9535542905867

Cancelar Ajuda

Figura 3 — Exemplo de célculo de longitudes relativas as camadas de dados.
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B. CALCULO DE AREAS/ PROJECAO DE COORDENADAS

4. Escolha um sistema de coordenadas projetadas que l|he pareca
adequado ao calculo de areas e reprojete os dados “On the Fly”.

Consulte o Guia Técnico Sophia — Sistemas de Informacédo Geografica:
Analise Espacial, para informacdo complementar sobre sistemas de
referenciacao e o exercicio 2.1 para recordar o procedimento em QGIS.

5. Adicione um campo a cada uma das tabelas de atributos das camadas
de mar, para preencher com o calculo de areas em km?2.

5.1 Abra a Calculadora de campos =% e escolha, para 0 novo campo, um
nome diferente de qualquer outro campo existente na Tabela de Atributos
(ex. area_km2).Escolha o tipo Numero inteiro e mantenha os 10 digitos.

5.2 Na Expresséao faca $area / 1000000 (porque os dados estdo em metros
guadrados).

Tenha em atencdo que, se tiver algum elemento da tabela selecionado, a aplicacdo
seleciona automaticamente a opc¢ao “Apenas atualizar 1 elemento selecionado”. Tire esta
opcao para que o célculo ocorra em todas as linhas da tabela.

6. Quais as areas, em km?, de cada camada de dados?
7. Qual a areatotal de Mar territorial?
8. Qual a areatotal de Zona Econdémica Exclusiva?

Como exemplo ficam aqui as areas das ZEE portuguesas, calculadas neste exercicio:
294 000 km?; 926 000 km? e 473 000 km?, respetivamente para as ZEE de Portugal
Continental, Acores e Madeira.

9. Qual a areatotal de Extensao da Plataforma Continental?

10.Pesquise na Internet as areas calculadas e discuta as razdes para as
diferencas encontradas.

Como exemplo ficam aqui as areas das ZEE portuguesas, retiradas da Wikipedia:

32



Ell Fortugal Continental 327 667 km?
B Acores 953 633 km®
Bl Madeira 446 108 km*

11.Grave e feche o projeto.
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Exercicio 2.3

PORTUGAL NO MUNDO | EDICAO
VETORIAL

Objetivos

O principal objetivo deste exercicio é determinar a drea territorial de
Portugal e a area correspondente as aguas marinhas portuguesas,
tendo por base informacdo geografica oficial disponibilizada pela
Direcdo-Geral do Territério (DGT) e pelo Instituto Hidrografico (IH).

Neste exercicio ira ter acesso a informacdo referenciada em sistemas
de coordenadas distintos, pelo que realizara tarefas de transformacéo
e projecao de coordenadas.

Ira, também, realizar uma série de tarefas de edic&o e processamento

de forma a simplificar, editar, corrigir e extrair a informagao pretendida,
nomeadamente gerir e editar informacdo das tabelas de atributos, homo-
geneizar e agregar informacao espacial ndo necessaria, fazer edicdo ve-
torial, rotular informac&o e calcular areas.

Este exercicio esta distribuido por trés etapas: uma primeira onde se
introduz a problematica dos sistemas de coordenadas (Ex. 2.1); uma
segunda etapa que aborda a gestdo de campos de tabelas de atributos
(Ex. 2.2) e, finalmente, uma terceira etapa, de edigdo vetorial (Ex. 2.3).

A. ABRIR E EXPLORAR UM PROJETO QGIS | EDICAO
VETORIAL

1. Abrao projeto QGIS que gravou no exercicio anterior (2.2).

2. Junte todas as camadas de dados com informacé&o de 4guas marinhas
numa mesma camada de dados e edite a respetiva simbologia em
funcdo do seu descritivo:
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2.1 Utilize a ferramenta Juntar camadas vectoriais, em Vector »
Ferramentas de gestdo de dados, selecionando a seguir as trés
camadas a agregar no campo Layers to merge (Figura 1). O programa
cria uma nova camada temporaria, sendo necessario grava-la (BLDR »
Guardar como...), escolhendo o nome (por exemplo, “zonas_marinhas”)
e o local de gravacéo.

Se fossem apenas duas camadas a juntar, poderia utilizar a ferramenta Merge
vector layers em Ferramentas de processamento » Geoalgorithms » Vector
» General tools.

Vector | Raster BasedeDados Web Processamento  Ajuda

OpenStreetMap | o 3 E ] .-:-: '”l'f.';;t - ’ 0 v
Ferramentas de investigacio ] t . )

Ferramentas de geoprocessamenta ® ’ I S » el
Ferramentas de Geometria L4

Ferramentas de Andlise 3

Ferramentas de gestdo de dados ¥ |7 Separar uma camada vetorial

451 Juntar atributos por localizacdo
¥ Definir projecio atual
& Criar indice espadial

Juntar camadas vectoriais

Figura 1 — Ferramenta para agregar diferentes camadas vetoriais.

Neste momento devera ter uma camada Unica em que as areas marinhas de Portugal estdo
representadas nas entradas da respetiva Tabela de Atributos (Figura 2). Para simplificar
a visualizagdo e o processamento do projeto SIG, e uma vez que ndo serdo mais
necessarias, podera remover as camadas iniciais/originais.
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NATION Descritivo
Zona Econdmica Exdusiva

Zona Econdmica Exdusiva

Zona Econdmica Exdusiva

Mar Territorial

Mar Territorial

Mar Territorial

Mar Territorial

Mar Territorial

Mar Territorial

"Ef’ul’uf‘ul’uﬂl’uﬁI

ExtensaoPlataformaContinental

5}

< >

[T vsrs otsscmas] [

Figura 2 - Camada de dados resultante da agregagédo dos trés poligonos com areas marinhas portuguesas.

2.2 Edite a simbologia da camada em funcé&o do campo Descritivo, utilizando
as seguintes cores, sem contorno:

Mar Territorial — #93c2cc
Zona Econdémica Exclusiva — #20c3e8
Extensado da Plataforma Continental — #397793

Com o BLDR sobre a camada, selecione Propriedades e escolha o separador Estilo.

Escolha Categorizado = e a coluna Descritivo. Clicando em Classificar, aparece
automaticamente a lista de valores da coluna Descritivo, com a escala de cores
selecionada. Para alterar faca duplo cligue em cada um dos quadrados de cor €, na janela
do Selecionador de simbolos, em Cor, copie cada uma das “anotagbes HTML” indicadas.
Faca OK em cada uma delas e escolha Aplicar na janela das Propriedades da Camada.

A simbologia pode ser gravada num ficheiro “.gml” e posteriormente
replicada.

2.3 Grave um ficheiro que contenha a informacéo sobre a simbologia que
utilizou. Para gravar a simbologia gerada, clique no botdo Estilo
(localizado na parte inferior da janela de propriedades da camada),
escolhendo Guardar estilo e Ficheiro de Estilo de Camadas do QGIS.
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2.4 Veja a Tabela de Atributos da nova camada de dados e preencha a
informacéo em falta utilizando a Calculadora de campo:

2.4.1 Selecione na Tabela de Atributos os elementos da mesma camada (e.g. as
trés linhas da Zona Econdémica Exclusiva), faca Editar e abra a Calculadora de
campo escolhendo Atualizar campo existente, para o campo “Descritivo” e
escrevendo, na janela da Expressao, ‘Zona Econdémica Exclusiva’ (utilizando
plicas simples () e ndo duplas (“)). Faca OK.

Os elementos da ZEE passam a estar identificados na tabela com esta designacao, no
campo “Descritivo”.

2.4.2 Repita 0 passo anterior para 0s elementos da Extensdo da Plataforma
Continental (os elementos de Mar Territorial j& estavam preenchidos para o
campo Descritivo).

Sempre que se trabalha com a Calculadora de campo, é necessario ter

0 atencdo aos elementos que estdo selecionados na tabela de atributos e ao
primeiro elemento da janela da calculadora (“Apenas actualizar x elementos
seleccionados”).

3. Produza uma nova camada de dados que contenha as areas marinhas
de Portugal representadas por apenas um poligono para cada origem
(Descritivo) de dados.

3.1 Esta acao efetua-se através da ferramenta Dissolve do menu Vector »
Ferramentas de geoprocessamento (Figura 3), desativando a opcéo
Agregar tudo, para poder usar o campo Descritivo.
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Configuragdes Modulos | Viector | Raster Base de Dados Web  Processamento  Ajuda

47 @ E:;, &@ OpenStreetMap » a [E| E % Q - I:Qg . %

: § Ferramentas de investigacdo [
% @ v ,ﬂ l'.’-l- | Ferramentas de geoprocessamento b | &’ Interseccdo

Ferramentas de Geometria 4 p Diferenca simétrica

= I Y

Ferramentas de Analise 4 Buffer com distindia variavel

Ferramentas de gestio de dados 3 T

[ 4
|' Dissolve
l

Diferenca

Buffer com distindia fixa
[l Cortar

Eliminar fragmento de poligonos

Paligono convexo minima

Figura 3 - Ferramenta para “dissolver” diferentes registos — Dissolve.

Esta acdo permite “dissolver” informagao tendo por base caracteristicas comuns de uma
Tabela de Atributos (que neste caso passa a ter apenas 3 elementos).

Note que ao aplicar esta acdo muita da informacéo parcial contida na Tabela

0 de Atributos pode perder-se, uma vez que cada registo s6 pode conter um
valor para toda a extensdo espacial representada. Ainda, se deixar ficar

ativada a opcdo Agregar tudo, a camada resultante agrega tudo num sé
registo.

4. Edite a simbologia da camada de dados, dissolvida por “Descritivo”,
com a mesma paleta de cores utilizada anteriormente. Importe a
simbologia aplicada na camada de dados anterior.

4.1 No campo de edicao do estilo da camada, importe em Carregar Estilo o

ficheiro “.qmFl que gravou em 2.3.

Remova as camadas e dados que originaram a camada simplificada.
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5. Junte as &reas administrativas das regides portuguesas numa unica
camada de dados.

5.1 Qual a ferramenta de processamento mais adequada e porqué?

6. Simplifique as areas referentes aos limites administrativos, de forma a
representar, em apenas um poligono, as regibes administrativas
portuguesas.

6.1 Qual a ferramenta de processamento mais adequada e porqué?

Esta operagéo ira simplificar a representacéo e otimizar a visualizagdo/processamento do
seu projeto.

B. EDICAO VETORIAL

Neste ponto ird proceder a algumas tarefas de edi¢ao
vetorial.

Poderd verificar que existem lacunas! de
representacdo entre o Mar Territorial e a porcao
terrestre de Portugal (Figura 4). Para corrigir estes
espacos vazios ira criar e editar uma nova shapefile
do tipo polygon, onde ird preencher 0s espacos
vazios.

Figura 4 — Lacunas entre as camadas de dados simplificados dos
limites administrativos de Portugal e das aguas marinhas
portuguesas.

1 Estas lacunas correspondem as aguas interiores que estéo definidas oficialmente e podem ser encontradas na internet. No
entanto, para fins deste exercicio iremos assumir que esta informacéo néo nos é disponibilizada.
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A edicdo vetorial tem por base as barras de ferramentas Digitalizacao

o™ .o o
L AV olip” 0 /% e Digitalizac&o Avancada

N & @O E Hapapde = . _
B 9 ARG SRR R S N . Para comecar a editar as

camadas de dados vetoriais devera acionar 0 modo de edicdo em # (Alternar Edicao).

Quando terminar a edicdo devera utilizar a ferramenta . (EdicOes Atuais), que permite
guardar ou cancelar as alteracdes realizadas nas camadas.

7. Crie uma shapefile nova, do tipo Polygon, para representar as areas
entre as duas camadas de dados existentes.

7.1 A criagdo de uma shapefile vazia podera ser efetuada através da
ferramenta Nova Camada Shapefile do menu Camada » Criar Camada
(Figura 5).

Figura 5 - Caixa New Shapefile Layer, para gerar uma shapefile vazia.

7.1.1 Preencha os diferentes campos solicitados, escolhendo o Tipo Poligono e
utilizando o sistema de coordenadas geogréficas baseadas no datum WGS84.

8. Inicie a edicdo do poligono adicionado e desenhar poligonos que
preencham as lacunas espaciais do mar territorial.

8.1 No caso de a nova camada de dados nao ter sido automaticamente
adicionada ao projeto, adicione-a e inicie 0 modo de edicéo vetorial.
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] = .
8.2 Desenhe um poligono & com contornos aproximados? de uma das
lacunas existentes.

8.2.1 Desenhe a forma pretendida dando cliques sobre o desenho, terminando com
0 BLDR e atribuindo-lhe um identificador, que ira aparecer na Tabela de
Atributos, no campo criado automaticamente (id) (Figura 6).

A qualguer momento da edicdo podera acrescentar campos na Tabela de Atributos desta
nova camada, que irdo aparecer para preenchimento nos poligonos criados futuramente
nesta camada.

// lacunas - Atributos do elemento ﬂ
ff)' id |l )
Local

/; /" lacunas :; Features total: 7, filtered: 7,s.. — O
Cancelar P i y [ J‘ ﬁj g = 7 - "'?' b ) 24
123id v |=|E w | | Actualizar Tude | Actualizar seleccionados

=
id Local al

dei

2 A O

B cores Oc

3 3 Acores Qr
v

T Mostrar todos os elementos,

Figura 6 — Novo poligono para colmatar uma das lacunas existentes, com a tabela para preenchimento simultaneo
da edigdo. A direita, a Tabela de Atributos, editavel durante a digitalizag&o dos poligonos.

8.2.2 Escreva um descritivo relativo ao poligono que desenhou na respetiva entrada
da Tabela de Atributos (e.g. Local). Este novo campo ird aparecer para
preenchimento em futuros poligonos desenhados (Figura 6, direita).

8.3 Repita este procedimento para outras lacunas a sua escolha, explorando
em simultaneo as diferentes ferramentas disponiveis nas barras de
ferramentas de digitalizacdo.

8.4 Desenhe grosseiramente, para cada uma das restantes lacunas, poligonos
alargados que incluam toda a extensdo das lacunas, sem se preocupar
com 0s contornos proximos das restantes camadas de dados. Tome como
exemplo a Figura 7. Grave as edicdes e feche o modo de edi¢céo (BLDR

2 No ambito deste exercicio ndo dé importancia a precisdo com que contorna as lacunas, particularmente no que diz respeito
ao limite adjacente a camada CAOP, uma vez que esta apresenta uma definicdo extremamente rendilhada e dificil de
reproduzir através desta edicao simples.
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» Guardar as edi¢cOes da camada e em seguida desativar o botdo de
Edicao /)

Projects  Editar Ver Camada Configuracdes Modulos Vector Raster BasedeDados Web  Processamento  Ajuda
NEBRRR40*2LSPAPPALBRNL Q6 K & LEET = 95
VGRA%-@-QR-%BV.- #/IBE--BrE < 6 “QFE x5~ &

g x

\Painel de Pesquisar
JErT®o
4 | DirecaoGeraTermritorio ~
I ArgAcores_GCentral_AAd_Ci
5 ArgAcores GOcidental_AAd_
3 ArgAcores_GOriental_AAd_C
(72 ArqMadeira_AAd_CAOP2014
U ArqMadeira_AAd_CACP2014
(55 Cont_AAD_CAOP2014.shp
b | InstitutoHidrografico v
<
Painel das Camadas g x
S A®T&-HAL |
B lacunas
[ vimites_politicos

- () ZonasMarinhas
B ExtensacPlataformaContinental
Mar Territorial
[ Zona Econdmica Exclusiva
|

: e T =
Coordenada|  -32.52,39.45 %9 Escdla 1:5129872 v || Magnifier 100% 2| Rotacio 0.0 3 Mipesenhar  @epscann @
= =

Figura 7 - Exemplo de criagdo de poligonos em torno das lacunas espaciais entre os limites administrativos e as
aguas marinhas.

9. Operacdes de edigdo — Diferenca

Para redefinir a forma dos poligonos alargados em funcgéo de limites de outras camadas
de dados (neste caso os limites administrativos CAOP e as 4guas marinhas) podera utilizar
a ferramenta Diferenca, incluida no grupo de Ferramentas de geoprocessamento do
menu Vector.

9.1 Aplique a ferramenta Diferenca até obter uma camada que contenha
apenas as lacunas entre as camadas de dados CAOP e Aguas Marinhas.
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Uma caracteristica muito comum em QGIS (e em outras aplicagdes SIG) € a
existéncia de varios procedimentos (ou aplicagdo de sequéncias de
ferramentas distintas) para se atingir o mesmo objetivo, sendo
particularmente percetivel na edi¢éo e andlise de dados.

Podera aplicar diferentes ferramentas de geoprocessamento, que lhe permitem atingir o
mesmo objetivo. No caso da Figura 8, o resultado foi conseguido pela utilizacdo de duas
diferencas: entre as camadas de zonas marinhas e de lacunas, seguida da diferenca entre
a camada resultante com os limites CAOP. As linhas estreitas exteriores referem-se as
lacunas entre as camadas de Mar Territorial e Zona Econdémica Exclusiva.

Figura 8 — Lacunas entre as camadas de dados CAOP e Aguas Marinhas no arquipélago dos Acores (a esquerda);
poligonos de lacunas, obtidos utilizando a ferramenta de geoprocessamento Diferenga.

10.0Operacdes de edicdo - Juntar camadas vetoriais

10.1 Junte a camada de dados com o preenchimento das lacunas a camada do
“Mar Territorial”, utilizando a ferramenta Juntar camadas vectoriais do
menu Ferramentas de gestao de dados.

Esta operacao resulta num conjunto de poligonos que pode ser posteriormente “dissolvido”
com a ferramenta Dissolve, passando a constituir o mesmo elemento (Figura 9).

Figura 9 — Zonas de Mar Territorial no Grupo Central do Arquipélago dos Acores, antes e apds as tarefas 6 a 9
(eliminag&o das lacunas entre as zonas de Mar Territorial e os limites CAOP).
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10.2 Grave as edic¢oes, feche o editor e remova as camadas de dados que
serviram de apoio a edi¢ao efetuada.

11.Crie uma shapefile de pontos, a semelhanca do que fez no ponto 6, com
o nome “localizacao", e marque um ponto em cada grupo de ilhas (trés
nos Acores e um na Madeira) e outro ponto no centro geométrico de
Portugal Continental.

11.1 Crie a shapefile de pontos vazia, adicionando um campo de texto, com o
nome “Descritivo”, onde ira escrever a descrigdo geografica de cada um
dos pontos.

11.2 Inicie o modo de edicdo desta camada de dados.

Go

11.3 Carregue em *“ para comegcar a desenhar pontos:

11.3.1 Marque um ponto aproximadamente no centro do Arquipélago da Madeira e
escreva “Arquipélago da Madeira” no campo “Descritivo” da Tabela de
Atributos. Repita este procedimento para o Arquipélago dos Acores,
adicionando um ponto para cada um dos grupos: "Acores grupo ocidental”,
“Acores grupo central” e “Agores grupo oriental”.

11.3.2 Cologque um ponto no centro geografico de Portugal, mas neste caso utilizando
a sua localizagao precisa: Lat: N 39°41’ e Long: W 8°7’.

Existe um elevado namero de plugins ou mddulos para QGIS que complementam a
aplicacdo e podem ser geridos no menu Médulos » Gerir e Instalar Modulos (Figura
10).
T
11.3.3 Instale 0 médulo Numerical Digitize * e abra-o a partir da Barra de
Ferramentas Digitalizacdo, preenchendo a tabela com as coordenadas
pretendidas e em seguida dando a descrigao “Portugal continental” no ponto
criado.

11.4 Verifigue se a Tabela de Atributos tem 5 pontos, grave as edicdes
efetuadas e feche o modo de edicéo.
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Figura 10 — Janela de pesquisa e gestdo de médulos no QGIS.

C. ROTULOS DE DADOS (LABELS)

12.Coloque roétulos (labels) em cada um dos pontos com ainformagéo que
esta no campo “Descritivo”.

12.1 Com o BLDR sobre a camada “localizacao" abra a janela de Propriedades
e o separador Etiquetas.

Mude de “Sem rétulos” para “Show labels for this layer’ e selecione o campo
“Descritivo” como informagédo a mostrar em Label with (Figura 11).

Nesta caixa podera ainda gerir os rotulos de dados, editando a sua simbologia, bem como
definir a posigéo do texto relativamente ao ponto marcado no mapa.

@

@

@
HER O

Figura 11 - Exemplo de representagdo das ilhas com etiquetas e janela de propriedades da camada.
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D. CALCULO DE COORDENADAS (OPCIONAL)

O QGIS permite efetuar o calculo das coordenadas dos diferentes dados espaciais

representados.

13.Calcule as coordenadas dos pontos referentes as localizagbes que

adicionou.

.‘.!—.
13.1 Adicione dois campos ~ na Tabela de Atributos da camada de pontos,

um para a latitude (Lat) e outro para a longitude (Long) (Figura 12).

13.2 Calcule as coordenadas através da ferramenta Calculadora de campo =
da respetiva Tabela de Atributos. Escolha Atualizar campo existente,
selecione o campo respetivo e escreva $x para os valores de longitude e

$y para os de latitude (Figura 12).
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2 4 Arq Acores Oriental 37.44997 -25.30515

3 3 Arg Agores Central 38.68916 -28.04852

4 2 Arg Agores Ocidental 39.59712 -31.15040

1 Arquip Madeira 32.84585 -16.55481

Figura 12 — Tabela de Atributos da camada de pontos criada (a); janela para adicionar campos (b); Calculadora de

campo e forma de calcular a coordenada x na Tabela de Atributos (c); coordenadas calculadas (d).
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Dependendo do tipo de campo que escolher (texto ou numérico), tera opgcdes
diferentes para a descri¢cdo de coordenadas. Além disso, estes campos ndo
sdo dinadmicos, pelo que se editar esta camada de dados, alterando as
posicdes dos pontos, a informacédo destes campos néo é atualizada. Devera
nestas circunstancia voltar a efetuar o calculo das coordenadas.

E. CALCULO DE AREAS (OPCIONAL)

Este passo pretende calcular as areas associadas as por¢des maritima e terrestre de
Portugal.

Para atingir este objetivo torna-se necessério converter o sistema de coordenadas que
estamos a usar, de um sistema geografico para um sistema de coordenadas projetado.
Como o principal objetivo é o calculo de areas, a sele¢cdo de uma proje¢cdo conservativa
desta propriedade é fundamental (ver o Guia Técnico Sophia — Sistemas de Informacé&o
Geografica: Anélise Espacial para informagdo complementar sobre sistemas de
referenciacdo e projegfes cartograficas).

As recomendacdes da Comissdo Europeia, através da diretiva INSPIRE, estabelecem o
uso da projecdo Azimutal de Lambert de areas iguais (LAEA — Lambert azimuthal
equal-area) para a realizacdo de analises estatisticas e visualizacdo. A sua natureza
conservativa de areas faz com que seja a projecdo mais adequada para a realizacao de
andlises que envolvam quantificacdes de distancias e areas.

14.Adicione um campo numérico designado por “area” as camadas de
dados com informacédo de Portugal terrestre e 4guas marinhas.

15.Projete o mapa utilizando uma projecéao do tipo LAEA.

15.1 Nas propriedades do Projeto ( @ EPSG:3633 I:'3-'-'::') selecione o separador
SRC e faga uma pesquisa de sistemas de coordenadas por “LAEA”.

15.2 Escolha a projecao “PTRA08 LAEA Europe” por ser a recomendada pela
diretiva INSPIRE® para esta regido geografica.

16.Quais as areas de mar e terra, em km?, de Portugal?

3 Caso esteja a trabalhar apenas na regido continental de Portugal devera escolher a projegdo
“ETRS 1989 LAEA” uma vez que esta dentro da area de competéncia do datum europeu ETRS89.
Fora da area do ETRS89 recomenda-se a utilizagdo do datum ITRF (que constitui o datum de
referéncia do PTRAQS).
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16.1 Podera ver as estatisticas associadas as areas calculadas (e.g. somatorio,
valores maximo e minimo, média, etc.) na tabela de atributos (Figura 13).

16.1.1 Instale o médulo Statist pesquisando em Médulos » Gerir e instalar médulos
(esta fungéo ira aparecer no separador Vector).

17.Adicione a shapefile “World_EEZ_v8_2014_HR_edit’ da pasta de dados
do Exercicio 2. Explore a “importancia” geografica da Zona Econdémica
Exclusiva de Portugal na Europa e no mundo (Figura 13).

Explore, na Tabela de Atributos, a posicdo da ZEE portuguesa no campo “area_kmz2”
(ordenando este campo de forma crescente), em 247 ZEE. Compare a area da ZEE
portuguesa (1 720 161 km?), lida na Tabela de Atributos, com a média mundial
(605 416 km?), lida na tabela Statist.

Input vector layer: Wiorld_EEZ_v8_2014_HR_edit
[ Use only selected features

Terget field: area o2 -

[] Enable statistcs for text fieids

Statistics output:

Parameter valoe | E
| Count u7 |
| 27 |
lue  12.734483 [
8618033.041000 [

|
\
|

883838338

8618020306517
149537823.526679

e

valu |
|Median value 223533189700 [ A G
jsm\duddevm ‘f“\°°+a -%

1192032.059825
|Coefficentof v.. 1968946

[ v 0.00 : [] show gnd

Refiesh 3
T Xmax o | As plot
o% oK | cose 0.0 e

e

- :

. Portugal Continenta
4203 Amsterdam xsm’m Paul Isand
- <

Figura 13 — Zonas Econ6micas Exclusivas de varios paises do mundo, com destaque para a portuguesa, a amarelo.
Estatisticas para o campo area com o médulo Statist (a direita).
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EXERCICIO 3
AREAS MARINHAS PROTEGIDAS

Objetivos

Este exercicio agrupa uma grande variedade de funcionalidades do QGIS,
utilizando como tema as Areas Marinhas Protegidas de Portugal (AMPs) e a
sua area envolvente.

Ira descarregar informacao espacial disponibilizada na internet em diversos
formatos e sitios. Pretende-se, com este exercicio, efetuar uma série de
procedimentos espaciais de selecdo e filtro dos dados com interesse no
modelo de dados vetorial, e de seguida efetuar andlise em modelo de dados
matricial, e.g. geracao de mapas de declives.

A. ABRIR E ADICIONAR CAMADAS DE DADOS

1. Abra um projeto QGIS vazio e adicione as shapefiles que representam
as Areas Marinhas Protegidas (AMPs) de Portugal.

1.1 Antes de adicionar as camadas de dados, defina o sistema de referéncia
de coordenadas (SRC) para o seu projeto (On the fly, i.e., sem alterar as
coordenadas dos dados originais). Escolha o datum WGS 84, para unificar
as diferentes zonas no mesmo SRC! (utilize a fungéo Filtro se necessario,
para encontrar rapidamente este datum).

§
1.2 Adicione em "5 as varias shapefiles que se encontram na pasta AMPs
localizada na pasta de dados do Exercicio 3.

1 para mais informagdes consulte 0 Guia Técnico Sophia — Sistemas de Informagao Geografica: Anélise Espacial. Para
detalhes sobre as transformacdes utilizadas poderiam consultar o site: https://epsg.io/1967
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1.3 Simplifique a visualizagdo do Painel das Camadas, agrupando todas as
camadas.

1.3.1 Selecione as camadas AMP e BDLR » Agrupar Selecdo.

1.3.2 Nomeie o grupo de camadas como Areas Marinhas Protegidas (BDLR »
Renomearr).

2. Adicione a camada de dados que contém as areas marinhas
portuguesas finalizada no exercicio anterior e edite a sua simbologia
(dados na pasta do exercicio).

2.1 Altere a simbologia importando o estilo previamente gravado num ficheiro
do tipo .gml.

B. DESCARREGAR E IMPORTAR DADOS COM DIFERENTES
ORIGENS/FORMATOS

Neste ponto ir4 descarregar dados espaciais referentes a estruturas submarinas a nivel
global e do Oceano Atlantico. A disponibilizacdo de dados espaciais ocorre muitas vezes
em formatos distintos (nem sempre em formatos diretamente importaveis para o QGIS) e
encontra-se muitas vezes dispersa na internet. Aqui apresentam-se exemplos de sitios de
internet onde podera descarregar informacao geografica dos oceanos. Ira ainda selecionar
e filtrar os dados por caracteristicas espaciais e por atributos.

3. Navegue até ao sitio SEEF -Seamounts Ecosystem Evaluation
Framework e descarregue informacéo acerca dos montes submarinos
(https://sites.google.com/a/seamounteef.org/www/seamounts/working-
files ).

3.1 Copie o ficheiro descarregado para a sua pasta de dados.

O ficheiro descarregado (SEEF_V3.1.accdb) corresponde a um ficheiro Microsoft Access,
base de dados que ndo é diretamente importavel para o QGIS? No entanto, o0 QGIS
consegue importar ficheiros Excel.

3.2 Abra a base de dados Microsoft Access e explore as diferentes tabelas de
dados. Qual das tabelas contém informacdo com atributos de natureza
geografica?

2 Os dados também conseguem ser lidos através de uma ligagdo ODBC -
https://gis.stackexchange.com/questions/247853/connecting-gqgis-to-odbc-database-ms-access-accdb.
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E possivel que a aplicacdo dé um aviso de seguranca relativamente a contetdos
potencialmente danosos que foram desativados. Ative esse conteudo. Caso as tabelas ndo
carreguem automaticamente, faca BDLR » Abrir sobre cada uma delas.

3.3 Exporte para formato Excel a tabela SeamountList (BDLR » Exportar »
Excel) e grave-a na pasta do exercicio com a extensao .xIsx (por defeito)
e escolha Exportar dados com formatacéo e esquema.

4. Adicione a tabela Excel que contém atributos geograficos ao seu
projeto QGIS.

4.1 Faca-o através da funcdo Adicionar Camada Vetorial \"E pesquisando
na pasta onde guardou o ficheiro Excel.

A camada carregada surge com outra simbologia no Painel das Camadas Seamountlist
informando que os dados est&o disponiveis apenas em formato de tabela. E possivel neste
momento consultar a Tabela de Atributos da camada, mas a informacgéo espacial ainda
nao esta configurada.

wrin

4.2 Instale o médulo xyToPoint "+ através do menu Médulos (Figura 1).

4.3 Na janela do médulo escolha a camada e as colunas respetivas para
longitude e latitude (x e y), finalizando com Create Point Layer.

i s Xy TOPoOINt

this plugin creates a point layer based on tabular
coordinates

this plugin creates a point layer Dased on tabular coordinates

i k.

Figura 1 — Instalagdo do modulo xyToPoint (esquerda) e preenchimento dos campos de coordenadas na respetiva
janela (direita).

ApOs este passo, 0s pontos associados as posi¢cdes da cada um dos montes submarinos
ja se encontram representados no projeto. No entanto estes pontos sdo temporarios e
deverdo ser convertidos num shapefile de dados permanente.
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4.4 Converta o ficheiro de dados temporario SeamountList num shapefile,
carregando com BLDR e fazendo Guardar Como. Grave na pasta de
dados deste exercicio, nomeie o shapefile de “Seef Seamounts” e
adicione-a ao projeto. Remova os ficheiros temporarios.

5. Adicione um mapa de base para perceber a distribuicdo geografica dos
montes submarinos que adicionou.

5.1 Instale o modulo OpenLayers através do menu Modulos.

5.2 Verifigue se o0 CRS esta em modo “on the fly” (clicando no canto inferior

direito da janela, em @ €Pse:3857(OTF) ) ¢ altere 0 CRS para WGS 84 »
Pseudo Mercator.

5.3 Carregue o mapa Google Satellite em Web » OpenlLayers plugin »
Google Maps » Google Satellite (Figura 2). No Painel das Camadas
arraste esta camada para o final, para que figue por baixo das restantes
na visualizacao.

| QGIS 2.16.0-Nodebo - AE BX3.

Dados _Web Processamento  Ajuda

@) }g ) MetaSearch » L L il . 87 -~ L, B
‘ @  OpenLayers plugin L] OpenLayers Overview

& 0 » Terms of Service / About

OpenStreetMap

Google Maps Google Physical
Bing Maps
MapQuest
0OSM/Stamen

1 Apple Maps

Google Streets
Geogle Hybrid
Google Satellite
Set APl key

»
>
= |
»
»
>

Figura 2 — Menu do médulo dos mapas de base.

5.4 Para melhor visualizacdo altere a simbologia dos poligonos das zonas
marinhas, clicando com o BLDR sobre o grupo de camadas e em
Propriedades » Estilo. Em Simbolo clique em Alterar, em seguida em
Preenchimento simples e altere o Estilo de contorno para Linha sdélida.
Em Renderizacdo da camada » Transparéncia da camada, altere esta
para 70, terminando com OK (Figura 3).
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[v] ® Seef Seamounts
[¥] ' ZonasMarinhas
[v] . ExtensaoPlataformaContinental
(V] [:] Mar Territorial
[v] . Zona Econdmica Exdusiva

Figura 3 — Montes submarinos e areas marinhas sobre o mapa de base Google Satellite.

6. Navegue até ao sitio da internet GEBCO -General Bathymetric Chart of
the Oceans (http://www.gebco.net/) e explore a informacdo que
disponibilizam sobre 0s oceanos e sobre as estruturas submarinas.

Pretende-se descarregar deste sitio de Internet as descricdes e localizagcbes das estruturas
submarinas e a batimetria dos fundos submarinos para a regido de aguas marinhas
Portuguesas, com uma resolugéo de malha de 30 arco-segundos.

6.1 Descarregue, do sitio GEBCO, a informacdo sobre as estruturas
submarinas, em shapefile, e a batimetria dos fundos na area geogréfica
entre 42°W e 7°W, e entre 28°N e 49°N, em formato ESRI/ ASCI3. Guarde
os ficheiros descarregados numa pasta \GEBCO e extraia os ficheiros.

6.1.1 Nesse sentido, va a Data and products » Gridded bathymetry data e em Select
your data set, defina as coordenadas pretendidas, usando valores negativos
para as coordenadas a oeste e positivos para as coordenadas a norte (neste
caso, -42,28,-7,49).

Caso a grelha batimétrica ndo esteja ainda disponivel para download, continue com o
exercicio mantendo a pagina de internet aberta e volte a esta pagina mais tarde.

3 Para conseguir descarregar dados de batimetria do sitio GEBCO devera fazer um registo no sitio de
internet.

55


http://www.gebco.net/

6.2

Adicione as estruturas submarinas representadas por pontos

(“features-point.shp”) e linhas (“features-linestring.shp”).

C. SELECIONAR/FILTRARDADOS POR ATRIBUTOS

Neste ponto devera selecionar os pontos que representam apenas localiza¢des associadas
a montes submarinos. Para tal devera filtrar a informacédo com base nas caracteristicas
descritas na respetiva tabela de atributos.

7. Crie um novo shapefile de pontos que contenha apenas 0s pontos

7.1

7.2

relacionados com montes submarinos. Explore a tabela de atributos da
camada features-point.

Qual(quais) o(s) atributo(s) que permite(m) distinguir 0os montes
submarinos?

Faca uma selecdo por forma a individualizar apenas os pontos do tipo:
Seamout, Bank, Ridge ou Terrace. Utilize a opcado SelectFilter features

using form © | disponibilizada na tabela de atributos, escolhendo “Equal
to” na linha “type” e escrevendo cada um dos tipos descritos seguidos de
Adicionar a seleccédo atual em Select Features (Figura 4).

Para visualizar os dados selecionados mude para vista de tabela (no canto inferior direito

da Tabela de Atributos = ). Para juntar todos os dados selecionados no topo clique
em Move selection to top (). Para mostrar apenas os elementos selecionados clique

em

7.3

T Mostrar elementos selecionadog,

Crie um novo shapefile apenas com os dados que respeitam a condicéo
definida, através da funcdo Guardar como... (usando o BLDR sobre a
camada no Painel das Camadas) e escolhendo Guardar apenas o0s
elementos selecionados. Grave o0 novo shapefile com o0 nome
“Gebco_seamounts.shp”.

56



/B 2T 8

£, Expressdo :

(] North Ikaria name ‘ ‘ [] case sensitive | Exclude field, |
Nishi-fusei type | terrace a | [[] Case sensitive | Cqual to (=)

0O 1 | Cqual to (-

[] Maxwel meeting | | [] Case sensitive | Exclude field, |
Maximianc ————————

O proposer ‘ | [] case sensitive | Exclude field, |

[[] Mawson = E: o

] Mawson proposal_y ‘ | [[] Case sensitive | Exdude field, |

discoverer’ | | [[] Case sensitive | Exclude field, |

D Maury

[] Maury discovery_ ’ ‘ [[] case sensitive \_Exg!ud;ﬁeﬂ'

W MeuiceEwing history ’ ! [] Case sensitive | Exclude field, |
Maugham - 3 ——

O comments ‘ ‘ [] Case sensitive | Exdlude field, |

[] Matua ; 5

[0 Matsuzak | Resetform | | Select features |v| | Fiter features ||

o | | RS
1 Mabenr

{ Y Mgstrar hcdos 0s elemenhos!

Seleccionar elementos

Adicionar & seleccic actual
Filter current selection

Remover da seleccao actual

Figura 4 — Selecao por atributos.

D.

SELECIONAR/FILTRAR DADOS ESPACIALMENTE

Pretende-se individualizar/extrair os pontos de montes submarinos e as estruturas lineares
gue estejam geograficamente nas aguas marinhas portuguesas.

8. Aplique a

8.1

8.2

8.2.

ferramenta Cortar (Vector » Ferramentas de
geoprocessamento) as camadas de dados com 0os montes submarinos
(SEEF e GEBCO) e a camada de dados com as estruturas geologicas
(camada features-linestring).

Faca Cortar as diferentes camadas de dados utilizando a camada de
zonas marinhas portuguesas como camada de recorte (Figura 5).

Grave cada um dos shapefiles de output com “_Pt” no final do nome (Figura
5).

1 Na janela da fungcdo Cortar, em Recortado, escolher, em E, Guardar no
ficheiro e escolher a pasta onde guardar e 0 nome para cada ficheiro.
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Figura 5 — Ferramenta Cortar (esquerda) e camadas cortadas resultantes (direita).

9. Explore espacialmente os dados disponiveis. Para facilitar a
visualizagdo, podera colocar transparéncia em algumas camadas de

dados poligonais (Figura 6).

9.1 Quais os montes submarinos que se encontram na Area Marinha Protegida
GreatMeteor? Qual a camada de dados Seamounts mais completa (no

gue respeita a GreatMeteor)?

9.2 Que estruturas cruzam a AMP Madeira Tore? Esta area marinha distribui-
se em que tipologia de aguas marinhas?

As questdes deste ponto podem ser rapidamente verificadas com a ajuda da funcdo
“Selecionar pelalocalizacéo” (Select by Location) no separador Vector » Ferramentas

de investigagéo.
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v & SIF_pt
¢ GEBCO_Pt
v Linestring_Pt
& Geboo_seamounts
T ® Seef_Seamounts
features-knestring
Areas Marnhas Protegdas

A L G S R A S R S G L

v . Extersacataformalontrentsl
v D Mar Territorial
v - Zone Econcmica Exdusve

Figura 6 -Cruzamento de informacéo espacial proveniente de vérias fontes de dados (a amarelo estdo os seamounts
e as estruturas selecionados.

E. ADICIONAR DADOS BATIMETRICOS | MODELO DE DADQS
MATRICIAL

10.Adicione a malha batimétrica dos fundos submarinos descarregada do
sitio da GEBCO.

10.1 Faca Adicionar Camada Raster 'u e adicione o ficheiro ascii
descarregado.
10.2 O que representa o aviso acerca do sistema de coordenadas que surge?

10.3 Apoés fazer OK, verifique se a matriz de dados esté corretamente localizada
(georreferenciada).

10.4 Qual o sistema de coordenadas dos dados?

10.5 Qual a profundidade méaxima observada?

11.Edite a simbologia da batimetria com uma gradacéo de cores a sua
escolha.
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F. PERFIL TOPOGRAFICO |[MODULO PROFILE TOOL

12.Faca um perfil batimétrico, orientado NE-SW, sobre o banco Gorringe.

12.1 Instale o médulo Profile tool a partir do menu Médulos » Gerir e instalar
maodulos (Figura 7). Apés a instalacdo, surge automaticamente o botéao

Terrain profile s .

o Lo Profile tool

’ [y
¢ e B S Aol

Plots terrain profile

This tool piots profile lines from raster layers, Supports multiple lines as well as export
to svg, pdf, png or csv file, Works with both Qwt5 and Matplotlib piotting libraries,

" 113 classificagdo de voto(s), 129548
transferénclas
|| Tags: raster, profile
Mais informagdo: pigina Inicial bug tracker gode repository

Autor: Borys Jurgiel - Patrice Verchere - Etienne Tourigny

Versao disponivel: 3.7.1 (In Repositério Oficial de Médulos do QGIS)

NI Ees L ywras rodm

Figura 7 — Janela de pesquisa de modulos.

Para encontrar rapidamente o banco Gorringe digite a
palavia no fitro de campos do menu filtro
T Mostrar todos os elementos, (i3 tabela de atributos,
escolhendo o campo que contém os nomes.

*

IRt

FPERECCEEERE

|

12.2 Abra a janela Profile tool e trace uma linha ao longo do banco (de acordo
com a Figura 8).
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Figura 8 -Perfil batimétrico por interpolacdo dos valores da malha ao longo de uma linha.

Podera ajustar alguns dos elementos do perfil, de forma a melhorar a sua visualizagéo,
assim como arrastar e aumentar o tamanho da janela Profile tool. Pode exportar o perfil
obtido no botéo Save as, escolhendo ao lado o formato do ficheiro para exportacéo.

13.Repita o0 ponto anterior para a orientagao perpendicular.

13.1 Qual a cota maxima atingida em Gorringe?

13.2 Qual a altura aproximada do banco Gorringe relativamente aos fundos
adjacentes?

G. MAPA DE DECLIVES

14.Construa uma carta de declives.

14.1 Faca um mapa de declives (em graus) a partir da malha batimétrica
utilizando a ferramenta MDE (Modelos de elevacdo) em Raster »
Anélise (Figura 10).
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14.1.1 Ap6s selecionar os ficheiros de entrada e saida devera escolher o Modo
Declive.

No célculo da carta de declives deveré ter atencdo a consisténcia entre as
unidades das escalas vertical e horizontal. Quando se esta a trabalhar em
coordenadas projetadas geralmente a unidade das escalas vertical e
horizontal sdo iguais (metro) pelo que na caixa escala (razdo entre as
0 unidades verticais e as horizontais) deverd colocar o valor 1. Quando a
camada esta em coordenadas geograficas, as escalas horizontal e vertical sdo
muito diferentes — grau e metro respetivamente. Atendendo que um grau de
latitude corresponde aproximadamente a 111 km, poderd utilizar-se o valor
(111000) na caixa de escala para obter um declive aproximado, no entanto,
sera sempre preferivel projetar os dados, pois a deformagdo pode ser
consideravel, principalmente & medida que nos afastamos do equador.

14.2 Qual o flanco mais inclinado do banco Gorringe?

",“'. ?J '.{;:0 £y
nﬁ.‘ - "\ - -
RGN ¢ i

- "9‘ *' 3 /

'O\’ﬂ"‘s : _(‘ Ly

Figura 9 — Mapa de declives.
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Exercicio 4.1

ANALISE ESPACIAL | INTEGRACAO DE
DADOS

Objetivos

Este exercicio tem por objetivo a implementacdo de um sistema de
caracterizacdo e classificagdo de materiais dragados através de um
estudo de caso - porto de Vila do Conde, exemplificando as diversas
fases de um projeto SIG.

0 sistema desenvolvido tem como base a legislagao em vigor para a
protecdo do meio marinho e a regulamentacdo das operacgdes de dra-
gagem.

O resultado final permitira a avaliacdo da qualidade ambiental dos
materiais dragados para efeitos de imersdo no mar.

Este exercicio encontra-se dividido em 2 etapas diferentes. Uma pri-
meira onde se procede a integracdo, conversado e geoprocessamento da
informacdo em SIG (ex 4.1). E uma segunda etapa (ex. 4.2) onde ser&o
abordadas ferramentas de geoprocessamento, como a interpolacdo de
dados pontuais, o calculo de volumes e a classificagdo das superficies
interpoladas.

A.ESTUDO DE CASO

Pretende-se avaliar a qualidade ambiental dos materiais dragados no porto de Vila do
Conde (Figura 1) para efeitos de imersdo no mar.

A caracterizagdo dos dragados sera efetuada segundo a Portaria n.° 1450/2007, de 12 de
Novembro, que classifica o material dragado de acordo com o grau de contaminacao de
alguns elementos metais e compostos organicos (Tabela 1) e os niveis de acao
estabelecidos para cada classe (Tabela 2) e a aptiddo ambiental (Tabela 3), disponiveis
em Anexo do exercicio 4.2.
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Figura 1 - Localizagdo da area de estudo — Vila do Conde.

B. Integracdo, conversao e geoprocessamento da informacao
geograficaem SIG.

Neste exercicio faz-se uso de diferentes tipos de dados, de forma a integrar a informagéo
geoespacial no projeto SIG. Os dados de base encontram-se listados na Tabela 1.

Tabela 1 - Descrigdo dos ficheiros de base do exercicio

NOME DESCRICAQ TIPO FONTE SIST. COORD.

Levantamento topo- Hayford-Gauss,

hidrografico do rio Ave numa | *-hp pTv. 1 p 1. | 2atum Lisboa;
area do porto de Vila do (shapefile) 27| Origem: PC;2

Conde. cota ao Z.H.

LEVTOPOHIDRO

Coordenadas das estagdes de | * gpf

e o =M=\l amostragem aos sedimentos IPTM, 1.p, | Hayford-Gauss, Datum

dragados (tabela). (dBaselV) Lisboa.
Resultados das andlises  dbf
ESTAM10S quimicas aos sednrqe_ntos - IPTM, 1.P. )
dragados de superficie (dBaselV)
(tabela).
Area de dragagem do porto de * sh 3
INSIF\0)=VXe B V/ila do Conde, Cais das P et e, | Hay ford-Gauss,
Lavandeiras. (shapefile) Datum Lisboa.

L IPTM, I.P. — Instituto Portuario e dos Transportes Maritimos, I.P., atualmente Diregdo Geral dos Recursos Naturais,
Segurancga e Servicos Maritimos - DGRM (https://www.dgrm.mm.gov.pt).

2 em QGIS este sistema designa-se por Lisboa Hayford Gauss IPCC, EPSG:102165.
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1. Preparacao do projeto SIG.

1.1 Inicie o QGIS.

1.2 Grave o projeto na mesma diretoria dos dados do exercicio, com 0 nome
Drag_Vconde.qgs

2. Exploragédo dos dados — QGIS Browser.

2.1 Sem fechar o QGIS Desktop, va ao Menu Iniciar e abra o QGIS Browser.

2.2 Procure a pasta com os dados do Exercicio 4 e explore os ficheiros
fornecidos, verificando os formatos de dados, a pré-visualizacdo das
formas e a tabela de atributos (Figura 2).

#% Navegador QGIS

g Atualizar @ Gerir WMS VEJ Nova shapefile &% Definir SRC da camada

header ~ || Param | Metadados | Pré-isuslizacio | Atributos |

Dados_QGIS_AE_Ex1
Dados_QGIS_AE_Ex2
Dados_QGIS_AE_Ex3
v Dados_QGIS_AE_Ex4
' areaDrag.shp
-~ areaDrag_ETRS.shp
) coord_Estam.dbf
[ ESTAM10s.dbf
0 LevTopoHidro.shp
Dados_QGIS_AE_Ex5
Dados_QGIS_AE_EXE

B 516 AE_BQ.3 ANS X pof

(7 SIG_AE_Fx2.3 ANS_X.pdf |~

Figura 2 — Navegador QGIS no separador de pré-visualizagao dos ficheiros.

2.3 Na aplicagdo QGIS Desktop, verifique se esta ativa a op¢cdo Enable ‘on
the fly’ CRS transformation (o0 simbolo no canto inferior direito devera

estar a preto @ EPSG:102165 (0TF) ¢ 3o a cinza €D EPSG: 102185 ) e se
nao estiver activa, avtive-a.

2.4 Arraste, do QGIS Browser para 0 QGIS Desktop, os dois ficheiros de
formato shapefile (.shp) e os dois de formato tabela (.dbf).
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3. Adicionar um orto com o servico WSM do IGEO.

3.1 V& a http:/lwww.igeo.pt/DadosAbertos/Listagem.aspx. Pesquise por
ortos e no resultado Cobertura Integral de Portugal Continental, va a
Servicos -> WMS. Copie o URL disponibilizado.

3.2 No QGIS, abra a opgédo Adicionar Camada WMS/WMTS em @H e no
separador Camadas escolha Novo, digite IGEO no nome e copie o URL
para a linha respetiva e cliqgue OK. Quando aparecer IGEO abaixo de
Camada, fagca Conectar e escolha Ortos DGRF. Faga Adicionar e
Fechar.

3.3 Arraste a camada para baixo no Painel das Camadas, para que nao se
sobreponha as restantes camadas.

Os elementos carregados com informacao espacial deverdo aparecer de modo semelhante
: _ ~
ao da Figura 3. Caso nao aconteca, faca Atualizar =

> @ postars
/£ Spatialite
& ArcGisFeatureServer
@ ArcGisMapServer

> ) ows
@& wcs
& wrs
> & wms
v
< >
ainel das Camadas B X

d@ov‘ri‘: v L »

[ areabraq
© LevTopoHidro
v [ B ortos DGRF

Figura 3 — Shapefiles carregadas sobre o ortofotomapa.
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4. Integracdo de informacédo em formato alfanumérico.

A incorporacdo de dados alfanuméricos (e.g. tabelas Excel, bases de dados néao
geograéficas, ficheiros .txt) € realizada diretamente no QGIS.

4.1 Observe a informagdo contida nas tabelas coord_Estam.dbf e
EstAm10s.dbf.
4.2 Represente a localizacdo das amostras: « xyTopoint  * EM

Inputtable or Layer

4.2.1 Ative o modo de edicdo e verifique se tem instalado o e =
w¥Ta
maédulo xy To Point *** | e clique no icone. Columa with X Coordinate Values
X_COORD -
4.2.2 Escolha os campos correspondentes a informacao X
e Y e selecione o correto sistema de coordenadas.

Column withY Coordinate Values

¥_COCRD -

4.2.3 Clique em Create Point Layer e depois Close. s ey o

Layername (Input Optional)
coord_Estam_pt_pt

Define CRS (optional)

O tema criado corresponde a uma Event Layer que ndo esta ® Proxctsetings O Layer
gravada no disco (como pode confirmar em Camada Fonte no
separador Geral da janela de Propriedades da Camada), sendo
necessario torna-lo permanente exportando-o:

Create Point Layer

Refresh all

4.2.4 BLDR sobre a camada » Guardar como..., com o
nome Pt_Estam.

4.2.5 Apague atabela coord_Estam e a respetiva Event Layer criada.

A tabela ESTAM10s contém a informagéo acerca dos elementos quimicos analisados em
cada uma das 10 estacbes de amostragem.

4.3 Relacione as duas tabelas (Pt_Estam e ESTAM10s) a partir de um campo
em comum:

4.3.1 Analise ambas as tabelas e encontre o campo comum DESIG_ESTA*
(designacéo da estagéo).

7 Unir camada vectorial
4.3.2 Com' o BLDR 'sobre a Pt_Estam.shp Camada aunr | esins S
selecione fProprledades e o separador Unr campo [ abeDESIGLESTA -
Uni6es ﬁi‘:] Campo alvo abe DESIG_ESTA -

Memorizar a camada unida em memdria virtual

4.3.3 Najanela selecione EII'IIT:' para criar uma nova L criar indice de atributos no campo de unido
tabela de unido: escolha a camada a unir b [ Escohrosconpos e
(EstAm10s), o campo comum a unir e 0
campo alvo, seguidos de OK.

P[] Prefixo personalizado do nome de campo
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4.3.4 Abra a tabela de atributos do tema Pt_Estam.shp. Verifiqgue se os contetdos
da tabela EstAm10s.dbf estéo ligados a tabela de atributos de Pt_Estam.shp.
Feche a tabela de atributos.

4.3.5 Exporte a camada Pt_Estam.shp com o nome Pt_Estam_10s de forma a
gravar definitivamente os dados unidos das duas tabelas (BLDR » Guardar
Como). Apague a tabela ESTAM10s e a camada vetorial Pt_Estam.shp.

5. Conversao de formatos de dados (vetorial/matricial) — definicdo de
mascaras

O préximo passo € a delimitacdo da area de estudo para a caracterizagdo dos materiais
dragados (area de dragagem), de forma a definir a &rea de analise espacial. Neste caso,
pretende-se que a mascara também se encontre definida em modelo matricial.

5.1 Converta o tema areaDrag.shp (em formato vetorial) para o formato
matricial.

5.1.1 Aceda ao menu Raster Conversdo P Rasterizar (Vector para raster),
definindo os parametros especificados na janela Rasterizar na Figura 4.

5.1.2 Grave o ficheiro com o0 nome areaDrag na pasta de dados deste exercicio.

5.1.3 Para criar a especificagdo do parametro Atributo a usar € necessario editar o
y

codigo em e acrescentar -a GRIDCODE. Pode acrescentar-se -a_nodata 0
para evitar que o programa desenhe a zona sem informacao, ou seja a zona sem
informagao (0) é atribuido o cédigo nodata.

5.1.4 Clique ok e feche a janela Rasterizar.

@ Rasterizar (Vector para raster) [ x|

Ficheiro de entrada (shapefile) areaDrag v | Seledonar...

Atributo a usar v

Ficheiro de saida para resultados (raster) I:/SOPHIAModulo_AE/FormacaoSIG_AE_janeiro201 = Selecionar...
Manter o tamanho e a resoluc3o do raster exitente

®) Tamanho do raster em pixeis

Largura | 300 v Altura | 300 s

Resolug3o do raster em unidades do mapa por pixel

gdal_rasterize -ts 300 300l-a GRIDCODE -a_nodata 0!-1 areaDrag I:
\SOPHIAWModulo_AE\FormacaoSIG_AE_janeiro20 16 \formacao_sophia_SIGae\DadosEx4\areaDrag.shp
[¥] Carregar no mapa quando conciuido| It /SOPHIA Modulo_AE FormacaoSIG_AE_janeiro20 16 /formacao_sophia_SIGae /DadosEx4/x. tif|

gdal_rasterize -ts 300 300 4 areaDrag I:
\SOPHIA Modulo_AE\FormacaoSIG_AE _janeiro20 16 \formacao_sophia_SIGae\DadosEx4\areaDrag.shp
I: /SOPHIA Modulo_AE FormacaoSIG_AE _janeiro20 16 /formacao_sophia_SIGae/DadosEx4/x. tif

Figura 4 — Especificacdes para a conversdo de vetor para raster. Exemplo de rasterizagdo com inclusdo do cédigo -
a_nodata 0 (imagem da direita) e sem inclusdo do codigo (imagem da esquerda).
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Exercicio 4.2

ANALISE ESPACIAL |
GEOPROCESSAMENTO

Objetivos

Este exercicio tem por objetivo a implementacdo de um sistema de
caracterizacdo e classificagdo de materiais dragados através de um
estudo de caso - porto de Vila do Conde, exemplificando as diversas
fases de um projeto SIG.

0 sistema desenvolvido tem como base a legislacdo em vigor para a
protecdo do meio marinho e a regulamentacdo das operagdes de dra-
gagem,

0 resultado final permitira a avaliacdo da qualidade ambiental dos
materiais dragados para efeitos de imers3do no mar.

Este exercicio encontra-se dividido em 2 etapas diferentes. Uma pri-
meira onde se procede a integracdo, conversdo e geoprocessamento da
informac&o em SIG (ex 4.1). E uma segunda etapa (ex. 4.2) onde serdo
abordadas ferramentas de geoprocessamento, como a interpolacdo de
dados pontuais, o calculo de volumes e a classificacdo das superficies
interpoladas.

Esta € a segunda parte do exercicio 4, em que se pretende avaliar a qualidade ambiental
dos materiais dragados no porto de Vila do Conde (Figura 1) para efeitos de imersdo no
mar. Aqui serdo abordadas a interpolacdo de dados pontuais, o calculo de volumes e a
classificagdo das superficies interpoladas.

A. INTERPOLACAO DE DADOS PONTUAIS

Os métodos de interpolacao sédo usados para estimar valores desconhecidos ao longo do
espacgo, a partir dos valores de amostras pontuais. Existem numerosos métodos de
interpolacé@o espacial que permitem atingir este objetivo, sendo neste exercicio abordada
a triangulacao e o inverso da distancia.
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1. Triangulagao

Para proceder a interpolacdo de dados topo-batimétricos utiliza-se, usualmente, um
método baseado na triangulacdo dos pontos de observacdo, em que a superficie
interpolada € composta por um conjunto de faces triangulares planas (malha irregular
triangulada - TIN). A caracterizacdo batimétrica da area de dragagem ira basear-se neste
método.

1.1 Construcao da malha triangulada — TIN

1.1.1 Abra o projeto criado no exercicio anterior (Drag_Vconde.qgs).

1.1.2 Verifique se tem ativado o Médulo de Interpolacédo, (em Médulos » Gerir e
Instalar Médulos), abra a ferramenta Interpolacédo de dados no menu Raster
» Interpolagdo e construa a malha triangulada para a camada
LevTopoHidro.shp usando os parametros abaixo especificados:

a. Parametros de entrada: escolha a camada LevTopoHidro, o atributo de
interpolagdo COTA e faga Adicionar (sem usar a coordenada z);

b. Pardmetros de saida: escolha o método de interpolagdo triangular e use para
tamanho das células X e Y o valor 0.1 (os restantes parametros ficam
automaticamente preenchidos) (Figura 1);

c. Grave o resultado com o nome TIN1 na pasta de dados do exercicio).

¥ Interpolacio de dados ? *
Entrada Saida
Camadas vetoriais LevTopoHidro A Método de interpolacdo | Interpolacdo triangular (TIN) - S
Atributo de interpolacdo | COTA - Mumero de colunas |2325 = | Mimero de linhas
[[] Use Coordenada-z para interpolacio Tamanho da célula % |D. 10000 < | Tamanho da célula Y
Adicionar Remover Xmin |-51218 | % max [-s0985.4 |
Camada vetorial  Atributo Tipo ¥ min ‘ 186984 | ¥ max | 187235 |
LevTopoHidra  COTA Pontos

Definir & extens3o atual

Ficheiro de saida |D:fSOPHIAﬂﬂoduIo4_AEfExercicioszGISfAE_EMﬂ'IN 1 |

< > Adicionar resultado ao projeto

Figura 1 — Janela de interpolacdo de dados - interpolagéo triangular.

1.2 Conversao do ficheiro TIN num raster.

1.2.1 Menu Raster » Conversdo » Traduzir, escolha o ficheiro TIN como Camada
de Entrada e nomeie o Ficheiro de Saida TI/Nraster. Faca OK e feche a janela
Traduzir.

1.2.2 Altere a simbologia para uma gradagdo de cores com intervalo igual
(Propriedades » Estilo).
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Como queremos que a andlise espacial corresponda apenas a area de dragagem, temos
de limitar a superficie criada.

1.2.3 Aceda ao menu Raster » Extracdo » Corte e escolha como Ficheiro de
entrada o recém-criado TINraster, dé ao novo ficheiro o nome TINraster_D e
escolha, como camada de mascara, a nova camada areaDrag com o SRC
correto. O resultado devera ser idéntico ao da Figura 2, direita, apds a escolha
de uma paleta de cores com intervalos iguais.

Figura 2 — Resultado das a¢Ges de conversao de TIN para raster e de corte deste a area de dragagem.

1.3 Calcular o volume de sedimentos a dragar.

1.3.1 Calcule o volume de sedimentos a dragar acima do plano de definido pela
profundidade -2m, na area de dragagem da TIN1. Para isso faga uso do plugin
SAGA.

a. Mude as opc¢des de visualizagdo das janelas de didlogo: Processamento » Opcdes
» Geral e selecione a op¢do Manter a janela de didlogo aberta ap6s execucéo
do algoritmo?.

(} Opgdes de processamento

| Procurar...

Configuragio

> Fornecedores

hd Geral
Ayvisar antes de executar se o SRC da camada ndo coincidir
Estilo para as camadas de linhas

Estilo para as camadas de poligonos

Estilo para as camadas de pontos

Estilo para as camadas raster

Extensdo padrdo da camada raster de saida

Extensédo padrdo da camada vectorial de sarda

@ Manter a janela de didlogo aberta apos execucdo do algori‘tmo|
[+ .

1 Aqui o programa podera solicitar 0 msys em falta, que pode ser descarregado a partir do MinGW
em https://sourceforge.net/projects/mingw/?source=typ redirect, instalando-se o pacote msys e
depois, no QGIS, procurando o caminho para onde o msys foi instalado.
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b. Em Processamento » Caixa de Ferramentas » SAGA » Raster Calculus, abra a
ferramenta Raster Volume.

c. Use como grid a TINraster_D, como método Count Only Above Level e como
nivel base o valor de cota acima do qual queremos calcular o volume (-2m).

(3 Raster volume

Parédmetros Registo Executar como processo em lote... |

Grid
[TIN1 [EPSG:102185]
Method

| [0] Count Only Above Base Level

Base Level

-2,000000

d. Faca Run e verifique na caixa de dialogo o volume calculado.

Converting outputs
Carregando as camadas resultantes =
Algorithm Raster volume finished -

[l 0% ]

2. Inverso da distancia

7

Para caracterizar os materiais dragados é necessario interpolar, para toda a area de
dragagem, os valores de concentragédo das substancias quimicas analisadas nas amostras
de sedimentos (recolhidas em pontos de amostragem especificos e em funcdo da cota de
dragagem, da espessura da coluna de dragados, etc.). Neste caso podem ser usados
varios métodos de interpolacdo, como métodos deterministicos (e.g. IDW e Spline) e
geoestatisticos (e.g. krigagem). Na resolucao deste exercicio vamos usar o método de
interpolacéo Inverso da Distancia Ponderada (IDW)2,

2 IDW - inverso da distancia ponderada — a forma como este método funciona pode ser consultada em:
http://resources.arcqgis.com/EN/HELP/MAIN/10.2/index.html#/How IDW_works/009z00000075000000/ .
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Analisando os resultados das andlises quimicas realizadas aos sedimentos de Vila do
Conde, e comparando-os com os niveis de acéo da legislacdo em vigor (Portaria n.° 1450/
2007), observa-se que, das varias substancias quimicas analisadas, o Chumbo (Pb) e o
Cobre (Cu) sao as que apresentam maior grau de contaminacao, pelo que ndo apresentam
aptiddo ambiental para a imersédo no mar (Tabela 1 e Tabela 2).

Neste sentido, e para simplificar a execucdo deste exercicio, vamos considerar apenas,
para efeitos de andlise espacial, estas duas substancias quimicas e sobre elas realizar as
operacdes de interpolacéo.

2.1 Interpolacdo dos elementos Chumbo (Pb) e Cobre (Cu).

2.1.1 Carregue a camada Pt_Estam gravada na primeira parte deste exercicio (4.1)
se esta ndo se encontrar ja carregada.

2.1.2 V& a Raster » Interpolacédo e escolha a camada vetorial do ponto anterior e
como atributo de interpolacdo o campo Pb (Figura 3). Como parametros de
saida escolha apenas o método de interpolagéo e o ficheiro de saida (Pb) e
clique em Definir & extensé@o atual, deixando os restantes em modo pré-

definido.
] Interpolagde de dados T >
Entrada Saida
Camadas vetoriais Pt_Estam10s A Método de interpolagdo | Ponderagdo pelo o inverso da disténda (IDW) S
Atributo de interpolaco  |ESTAM10s_P - Numero de colunas |3gg = | Mimero de linhas 300 =
Use Coordenada-z para interpolacio Tamanho da célula % | 1.62333 = | Tamanho da célula Y
Adicionar Remover X min ‘ 51112.7 | X max | 50524.2 |
Camada vetorial  Atributo Tipa ¥ min | 186651 | ¥ max 187214 |
Pt Fstamils  ESTAM10s P Fontos I Definir & extensdo atual I
Ficheiro de saida |D:fSOPHIA,."M0duI04_AE,|"ExerddoszGISfAE_Ex‘Upb |
< > Adicionar resultado ao projeto

oK Cancelar

Figura 3 — Janela de interpolacdo de dados — ponderagéo pelo inverso da distancia.

A interpolagédo resulta numa imagem do tipo banda
cinza simples, que representa valores de concentracédo
de Chumbo entre 75 e 179 (Figura 4). Estes valores
séo calculados automaticamente para a apresentacéo
do resultado, mas manipulando o histograma (em
BDLR P Propriedades » Histograma) podera
alterar estes limites. Porque o olho humano é mais
sensivel a diferentes cores do que a diferentes tons de
cinzento, é aconselhavel apresentar o resultado com
cores, para torna-lo mais compreensivel.

Figura 4 — Resultado da interpolacéo para a concentragdo de Chumbo.
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2.1.3 Corte o raster pelo contorno da shapefile areaDrag e apague o raster anterior.

2.1.4 Modifiqgue a simbologia de forma a representar a vermelho os valores de
concentracdo de contaminacdo mais elevados, e a azul os valores de
concentragcdo mais baixos: BDLR » Propriedades » Estilo » Banda de cor
falsa simples. Cor: Spectral. Inverter. Modo: Intervalo igual. OK (Figura 5).

2.1.5 Repita os pontos 2.1.2 a 2.1.4 para o Cobre (Cu)®.

' Pb_areaDrag : > . Cu2_areaDrag
M« A -y r  LE:

161 128

282 L | 4 217

402 7 308

| ol | EEE

Figura 5 — Superficies de interpolagdo em falsa cor para o Chumbo e para o Cobre, com a camada de pontos
sobreposta.

3. Classificacao das superficies interpoladas.

Tendo por base a legislacdo legal em vigor para a protecdo do meio marinho, que se traduz
nas tabelas anteriormente apresentadas, é possivel classificar os sedimentos dragados
relativamente a sua qualidade ambiental para imersdo no mar (Tabela 1).

3.1 Classifique as superficies de interpolagdo das substancias Pb e Cu de
acordo com a Tabela 1.

3.1.1 Abra a Calculadora Raster e digite a seguinte expressdo?, que representa as
diferentes classes e os respetivos intervalos de contaminagéo da Tabela 1 em
anexo:

("rasterPb" >=1000)*5 + (("rasterPb" < 1000) AND ("rasterPb" >=500))*4 + (("rasterPb" < 500) AND
("rasterPb" >=150))*3 + (("rasterPb" < 150) AND ("rasterPb" >=50))*2 + ("rasterPb" < 50)*1

A aplicacéo podera ter alterado o cabegalho da tabela de atributos da camada PT_Estam, aquando da unido das tabelas
ESTAM10s e Pt_Estam no exercicio anterior, 0 que exige uma comparacao dos valores com os da tabela original para se
saber qual a coluna a utilizar para o caso do cobre.

4 A expressdo “rasterPb” representa o nome do raster e é obtida através de duplo clique sobre o nome da camada.
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@ Calculadora raster

Banda raster Resultado da camada

cuz@1 Camada de saida E[Excerdicios/QEIS/AE_Ex4/Pb_Class| | |
Cu2_areaDrag@1
Cu_areabrag@i Formato de saida [eomiFF .|
rb@1
Pb2@1 Camada na sua extensio atual
Pb_areaDrag®1 = a
TNi@1 X min -51358,60000 - X max -50601,79900 v
TiNraster D@1

SRC de saida [aRe: selecrionan (FPSG:3763. FTRSAS fPor |25

("Pb_areaDrag@1” == 1000) * 5 + (("Pb_areaDrag@1" « 1000) AND ("Pb_areaDrag@1” >= 500)) * 4 + (("Pb_areaDrag@1” < 500) AND
("Pb_areaDrag@1” »= 150)) *3 + ([(Pb_areaDrag@1" < 150) AND ("Pb_areaDrag@1" = 50)) * 2 + ("Pb_areaDrag@1" < 50) * 1|

Calculadora de expressao raster

(Pb_areaDrag@1” »= 1000) * 5 + ((Pb_areaDrag@1" < 1000) AND (Pb_areaDrag@1" >= 500)) = 4 + ((Pb_areaDrag@1" < 500) AND
(Pb_areaDrag®1" >= 150)) * 3 +(('Pb_areaDrag@1” < 150) AND ("Pb_areaDrag@1" >= 50)) * 2 + ("Pb_areaDrag@1" < 50) * 1|

1

Express3o valida

3.1.2 Repita para a camada do Cobre tendo em atencdo que as classes deverdo
apresentar limites distintos em fungéo do descrito na Tabela 1. Tente usar o
procedimento alternativo que é a ferramenta r.reclass das Ferramentas de
Geoprocessamento. Use a seguinte codificagdo para o ficheiro de
reclassificagcéo:

0 thru 50 = 1 classe 1
50 thru 150 = 2 classe 2
150 thru 500 = 3 classe 3

500 thru 1000 = 4 classe 4
1000 =5 classe 5

Deste passo obtém-se as superficies de interpolacéo reclassificadas para as 5 classes de
contaminagédo, que podem configurar-se (BLDR » Propriedades » Estilo, Banda de cor
falsa simples, escolhendo 1 e 5 como valores minimo e maximo).

(3 Propriedades da camada - Cu_Class | Estilo

¥ Renderizar banda

Processar tipo |Eanda de cor falsa simples =

Banda |Banda 1 (Gray)

MR Prémides P Carregar valores min/max

|.‘ Transparéndia

|[ﬂ Histograma Interpolation | Linear

ri Metadados Cor DSpectral | Inverter

Label unit

- suffix |
Legenda

= ."I max Utilizador definido
origin:

Valor Cor Etiqueta
I
I

oK || Cancelar || Aplicar || Ajuda




No final ficamos com as camadas configuradas como as imagens da Figura 6, mostrando
o grau de contaminacao das classes 1 a 5, a interpretar de acordo com a Tabela 2.

. Classe 1

Classe 2
Classe 3
Classe 4

. Classe 5

Figura 6 — Reclassificagdo das interpolagdes para o chumbo (esquerda) e para o cobre (direita).

4. Classificacédo dos sedimentos

A classificagédo final de uma amostra de sedimentos resulta da conjugacgéao da classificagédo
das 11 substancias quimicas analisadas, i.e., 0 maximo em todas as substancias. A
classificacdo dos sedimentos em determinada posi¢do depende da classificacéo atribuida
ao elemento que apresente a maior classe de contaminacao nesse local. Nesse sentido, é
necessario fundir as superficies geradas anteriormente, usando a funcéo estatistica
MAXIMO. No caso deste exercicio, como usamos apenas 2 elementos, faremos este
célculo apenas nestes dois elementos.

4.1 Use a ferramenta r.series para calcular os valores maximos em cada
célula.

4.1.1 Em Processamento » Caixa de Ferramentas pesquise por r.series e escolha a
opgao “Makes each output cell value a function of the values assigned to the
corresponding cells in the output raster layers”, escolhendo para Input layers as
duas camadas com as classificacbes do Pb e do Cu.

41.2

(3 r.series - Makes each output cell value a function of the values assigned to the corresponding cells in the input raster layers.

Pardmetros |E!(ecu13r como processo em lote. .. |

(@ Multipla selegdo

-~

Input raster layer{s)

2 elementos selecdonados
[] Propagate MULLs
Aggregate operation

| maximum

iCu_Class [EPSG:3763]
Pb_Class [EPSG:3763]

[] Cu_areaDrag [EP5G:3763] | =

[] Cu2_areaDrag [EP5G:3763
[] Cu2 [EP5G:3763]
[] Pb2 [EP5G:3763]
[] Pb_areaDrag [EPSG:3763]
£ m >

Selecconar tudo
Limpar seleccdo

Alternar selecgio
QK

Cancelar
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O raster resultante € uma fusdo dos dois anteriores, com os resultados maximos das
classes para ambos os elementos (Figura 7). Comparando com as imagens da Figura 6
percebe-se que a aplicacdo escolheu apenas os valores maximos de classe em cada pixel.
Configurando da mesma forma as cores no separador Estilo, é possivel verificar as 3
classes correspondentes aos maximos (a classe 5 nao existia e a classe 1 foi “engolida”
pela classe 2).

Figura 7 — Camada resultante da aplicagdo da funcgéo estatistica MAXIMO nas camadas com os valores interpolados
de chumbo e cobre.

5. Caracterizacdo da aptiddo ambiental dos sedimentos

Pretende-se, em seguida, determinar as areas com aptiddo ambiental dos materiais
dragados para a imersao no mar. Assim, vamos reclassificar a superficie com os maximos
gerada no ponto anterior.

5.1 Reclassifiqgue os valores em 0 e 1, em funcdo da informacdo da Tabela 3
(0O — Proibida a imerséo no mar; 1 — autorizada a imersao no mar).

5.1.1 Abra a Calculadora Raster e aplique a férmula que atribui o valor 1 as classes
1,2 e 3 eovalor0 as classes 4 e 5. Digite a formula ("Aggregated@1" >= 4) *
0+ ("Aggregated@1" <= 3) * 1.

Em alternativa podera usat a funcao r.code com:
1.3:1:1
4:5:0:0
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5.1.2 Escolha, no separador Estilo, cores representativas das duas classes de
aptidao ambiental (por exemplo, vermelho para a proibi¢cao e azul ou verde para

autorizacao) e obtenha uma imagem semelhante a da Figura 8.

Figura 8 — Classes de aptiddo ambiental para os elementos chumbo e cobre.

B. ANEXOS

Tabela 1 - Classificacdo de materiais dragados de acordo com o grau de contaminacgao, adaptado da Portaria n.°
1450/2007, de 12 de Novembro.

PARAMETRO | CLASSE 1 | CLASSE 2 | CLASSE 3 CLASSE 4 CLASSE 5
Arsénio (As) <20 [20-50[ [50 — 100] [100 - 500] > 500
Cadmio (Cd) <1 [1-3 [3-5[ [5 - 10] > 10
Crémio (Cr) <50 [50 — 100[ [100 — 400[ [400 - 1 000] >1 000
Cobre (Cu) <35 [35 - 150[ [150 — 300[ [300 - 500] > 500
Merctrio (Hg) <0,5 [0,5- 1,5 [1,5-3,0[ [3,0-10] > 10
Chumbo (Pb) <50 [50 — 150[ [150 — 500[ [500 - 1 000] > 1000
Niquel (Ni) <30 [30 - 75] [75 - 125] [125 - 250] > 250
Zinco (Zn) <100 [100-600[ | [600 -1 500/ | [1500-5000] > 5 000
COMPOSTOS ORGANICOS (ug/kg)

PCB (soma) <5 [5 - 25[ [25 - 100] [100 - 300] > 300
PAH (soma) <300 [300-2000[ | [2000-6000[ | [6000-20000] > 20 000
HCB <0,5 [0,5-2,5[ [2,5-10] [10 - 50] > 50
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Tabela 2 - Niveis de Acédo - Classes de qualidade dos sedimentos (material dragado), adaptado da Portaria n.°
1450/2007, de 12 de Novembro.

Material dragado limpo - pode ser depositado no meio aquatico ou reposto
WSS = em locais sujeitos a erosdo ou utilizado para alimentacdo de praias sem
normas restritivas.

Material dragado com contaminacgao vestigidria - pode ser imerso no meio
O WiNSISI=WA aquatico tendo em atencdo as caracteristicas do meio recetor e o uso legitimo
do mesmo.

Material dragado ligeiramente contaminado - pode ser utilizado para
(O WANSYs =l terraplenos ou, no caso de imersdo, necessita de estudo aprofundado do
local de deposicao e monitorizacdo posterior do mesmo.

Material dragado contaminado - deposicdo em terra, em local
(WSS = impermeabilizado, com a recomendacdo de posterior cobertura de solos
impermeéaveis.

Material muito contaminado - idealmente ndo sera dragado; em caso
O WiNSISI=eal imperativo, deverdo os dragados ser tratados como residuos industriais,
sendo proibida a sua imersao e a sua deposicdo em terra.

Tabela 3 - Classes de aptiddo ambiental.

CLASSES DE APTIDAC IMERSAQ NO

AMBIENTAL
P/ IMERSAOQ

CLASSE 1 AUTORIZACAO
CLASSE 2 COM AUTORIZACAO 1

CONTAMINACAO MAR

CLASSE 3 COM AUTORIZACAO 1
CLASSE 4 SEM PROIBICAO 0
CLASSE 5 SEM PROIBICAO 0

Valor 1 — sedimentos dragados com aptiddo ambiental para a imerséo no mar;
Valor 0 - sedimentos dragados sem aptiddo ambiental para a imers&o no mar.
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Exercicio 5

REGISTO TEMPORAL DA POSICAQ DE
NAVIOS

Objetivos

Neste exercicio trabalharad com dados espacio-temporais, i.e., cuja infor-
macao varia no espaco e também no tempo.

Terd acesso ao posicionamento de navios junto a costa portuguesa durante
um dia e ira explorar as ferramentas de visualizacao do QGIS, para dados
temporais, efetuando alguns procedimentos de analise, como célculo de
velocidades, rumos e conversdo de posicionamentos de pontos para
percursos (linhas).

A. ADICIONAR TABELAS DE DADOS NO QGIS

1. Adicione a tabela de posicbfes de navios na costa portuguesa
(“Posic_navios.csv’) a um novo projeto QGIS e represente as
coordenadas com a localizacdo das embarcacdes no mapa através de
pontos..

1.1 Abra o QGIS Desktop e importe a tabela utilizando o botéo % (Adicionar
Camada de Texto Delimitado).

1.1.1 Na janela para adicionar a camada, em Procurar, navegue até a pasta com o0s
dados do exercicio e escolha o ficheiro .csv. Em Formato do ficheiro escolha
Delimitadores personalizados e verifique se estd selecionada a opcéao
Separador (Figura 1). Em Definicdo de geometria escolha, para X e Y, 0s
campos longitude e latitude da tabela de atributos, respetivamente. Faca OK.

1.1.2 Se nao definiu inicialmente o Sistema de Referéncia de Coordenadas (SRC), o
programa devera escolhé-lo automaticamente, de acordo com as opgdes de

83



predefinicdo do SRC para novos projetos. Escolha o sistema WGS 84 (sistema
em que os dados originais se encontram referenciados).

1.2 V& a Guardar como (utilizando o BLDR sobre a camada carregada) e
defina uma pasta para guardar os resultados deste exercicio (podera criar
uma nova pasta utilizando o BLDR na janela Guardar camada como...,
dentro da pasta onde desejar guardar). O ficheiro ficar4 agora guardado
com o SRC WGS84.

{# Criar uma camada a partir de ficheiro de texto delimitado

Nome do ficheiro lF:/SOPHIA/Modqu4_AE/Exerdcios/Exerdcios_SIG_AE/DadosExS/DGRM _posic_navios/Posic_navios.csv ] [ Procurar... I

Nome da camada |Posic_navios | Codificacdo

Formato do ficheiro () ¢sV (valores separados por virgula) ® Delimitadores personalizados () Delimitador de expressdes regulares

[] virgula Separador [] Espaco [] Dois pontos [] Ponto e virgula
Qutros delimitadores I | Citacdo |' l Escape |' ]

Opcdes de registo Nimero de linhas de cabegalho a descartar Primeiro registo tem o nome dos campos
Opgdes de campo [7] cortar campos [ Descartar campos vazios [ | Separador decimal é a virgula
Definicio de geometria ® Coordenadas de pontos O well known text (WKT) () Sem geometria (apena tabela de atributos)

Campo X [longitude »| Campo Y Ilaﬁtude « | [[] Coordenadas DMS

Definices da camada || Usar indice espacial ["] usar indice pardal [] vigiar ficheiro

X Y gid codigo latitude longitude r v time_stamp
-8.9292 40.4981 1250 120 40.4981 -8.9292 0 0 2015-06-10 08:05:00
-8.9276667 37.0103333 1226 175 37.0103333 -8.9276667 102 0O 2015-06-10 08:05:00
-8.685 40.6336667 1232 215 40.6336667 -8.685 202 0 2015-06-10 08:05:00
-8.756 40.7159 1285 226 40.7159 -8.756 0 0 2015-06-10 08:05:00
-9.4683333 40.047 1259 84 40.047 -9.4683333 354 4.3 2015-06-10 08:06:00
-7.621 37.002 1346 106 37.002 -7.621 52 0 2015-06-10 08:07:00

271 a1 171 1282 187 A1 171 -2 71 20 QR MIENA A0 NRN0T-00

OK || Cancelar |l Ajuda

Figura 1 — Janela de criagdo de uma camada a partir de dados de texto.

2. Adicione o mapa base Google Satellite em Web » OpenLayers Plugin
» Google Maps (tera de ter este plugin instalado — ver exercicio 3 deste
maodulo). Este mapa base funciona apenas com o SRC WGS 84/Pseudo
Mercator. Verifique se a aplicacdo alterou automaticamente para este
SRC e se esta a trabalhar em modo “on the fly”.

3. Explore os dados, sabendo que o campo Cdédigo identifica os navios.

3.1 Altere a simbologia do tema, dando cores diferentes a navios diferentes
(no separador Estilo das Propriedades da camada, escolha a opgéo
Categorizado, por cédigo, e escolha uma paleta de cores que melhor
permita distinguir os navios entre si) (Figura 2).
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4. Onde exerceram as suas atividades piscatdrias 0sS navios com 0sS
codigos 3, 13; 133; 233 e 313?

4.1 Utilize a selecdo de dados por atributos abrindo a tabela de atributos da
camada, escolhendo o botéo .

4.1.1 Digite o cédigo 3 na linha correspondente e escolha a opcdo Select features,
gue ira assinalar no mapa, a amarelo, as ocorréncias do navio selecionado.

4.1.2 Para adicionar os outros cédigos substitua o 3 por 13, escolhendo a opgéo
“Adicionar a seleccdo actual”.

4.1.3 Repita para os restantes cédigos, adicionando todos a selecao.

Figura 2 — Projecéo de todos os dados, com cores diferentes para diferentes navios.
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B. ATIVAR A FUNCIONALIDADE TEMPO NAS CAMADAS DE
DADOS

5. Ative as funcionalidades de tempo disponiveis para camadas de dados
com atributos temporais.

5.1 Instale o moédulo TimeManager (Figura 3).

Devera remover as expressdes de selecdo efetuadas no ponto anterior para
gue atotalidade dos dados seja representada.

Time Manager

n Export Video | Time frame start: [2015-06-10 08:05:00.000 | & | Time frame size:

“ O

Il 2015-06-10 08:05:00

Figura 3 — Barra do plugin Time Manager.

[ 3
2015-06-1108:57:00

5.2 No botdo Settings da barra Time Manager, preencha os diferentes
campos de acordo com o que conhece acerca da tabela de atributos e
sabendo que os dados representam 1 dia de posicionamento de navios

e format

Offse

(Figura 4).
I v Select layer and celumn(s) 7 x
B
Layer Posic_navios -
d Start ime time_stamp b
E End time No end time - accumulate features ~ | {optional)
Offset (in sec) | 1 5 | (optional)
i Interpolaton | No interpolation (faster) ~ | {optional)
ID attribute None - every geometry is a position of the same moving objectin tme (for interpolation)
[ 1gnore this layer when checking if scene is empty (for animation)
Cancelar
i
q Animation Options:
Show frame for miliseconds
[ Play animation backwards Looping animation
[[] Do not export empty frames in time managed layers
Display frame start time on map Time display options
oK

Figura 4 — Preenchimento das janelas de configurag6es do médulo TimeManager.

— .
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0
0 Desligando o botéo @ da barra Time Manager é possivel voltar a ver a
totalidade dos pontos da camada.

5.3 Observe a variacdo espacio-temporal dos dados explorando as diferentes
opc¢Oes de tempo.

5.3.1 Quais as areas com maior densidade de atividade piscatéria?

5.4 Repita a acdo anterior, filtrando os dados para apresentar apenas alguns
navios.

C. CRIACAO DE PERCURSQS

6. Crie linhas que representem o percurso de cada um dos navios com a
ferramenta Convert points to line(s) da Caixa de Ferramentas. Atribua
cores diferentes para percursos diferentes no novo ficheiro, a
semelhanca do que fez para os pontos (Figura 5).

,‘/ Convert points to line(s)

Parametros Registo Ajuda

Points

Posic_navios [IGNF:WGS84G]
Order by...

time_stamp
Separate by...

codigo

Lines

Figura 5 — Ferramenta Convert points to line(s) e resultado da sua aplicacdo ap6s edi¢éo do estilo.
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Note que as linhas correspondem a ligacdo entre pontos obtidos em momentos
descontinuos no tempo, ndo ao real percurso dos havios, originando percursos impossiveis
(Figura 6).

Figura 6 — Ampliagdo daimagem da Figura 5 a zona da Ria Formosa e porto de Faro.

D. MAPAS DE DENSIDADES

7. Produza um mapa de densidades com as posi¢cdes de navios.

7.1 Tente encontrar a ferramenta do separador Estilo nas Propriedades da
Camada que realize a acdo pretendida.

Figura 7 — Mapa de densidades das posi¢des dos navios.
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E. INTERCECAOQ DE ATIVIDADE PISCATORIA COM AMP'S

8. ldentifigue as embarcacdes que poderdo ter exercido atividade
piscatéria na AMP da Nazaré. Utilize como critério de pesquisa 0s
navios que demoraram mais de 2 horas a percorrer 1milha nautica®.

8.1 Adicione a camada de dados com a AMP da Nazaré disponibilizada na
pasta de dados do exercicio.

8.2 Selecione os dados/embarcacdes que durante o periodo em andlise
intersetaram a AMP Nazaré.

8.2.1 Verifique se as camadas Navios e AMP13_Nazaré estdo ambas no mesmo
SRC.

8.2.2 Utilize a ferramenta Intersection (Processamento » Caixa de ferramentas
» Geoalgorithms » Vector » Overlay) e escolha as camadas de acordo com
a Figura 8, seguidas de Run.

A aplicacdo cria, por defeito, um ficheiro temporario, que poderd ser gravado
definitivamente na pasta deste exercicio, com outro nome.

* Intersection ? >

Parédmetros Registo Ajuda

Camada de entrada

Mavios [EPSG:4326] || ||
Camada de Interseccdo

AMP13_MNazare [EP5G:4326] * | |ane | |
Interseccao

| [Guardar num ficheire tempararic] |

Abrir o ficheiro de saida apds a execugdo do algoritmo

Figura 8 — Ferramenta Intersec&o, com as imagens antes e apds a sua aplicagao.

1 Este valor é indicativo; podera utilizar um outro valor de referéncia.
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8.3 Quais as embarcacdes que demoram mais de 2 horas a percorrer 1 milha
nautica (equivalente a uma velocidade inferior a 0.5 n6s)?

8.3.1 Abra atabela de atributos e utilize o Filtro avancado (expresséo), escolhendo
o0 campo v (velocidade) e escrevendo a expressao da Figura 9.

¥ Expressio baseada no filtro ? X

Expressdo Editor de Funcies

=+ [= 1A= G| (e Pesquisa | ~
" <05 Aggregates # | | Double click to add field name to expression string.
Cadeia de texto Right-Click on field name to open context menu sample
¥ Campos e Valores value loading options. hd

}I‘:ULL Valores |Pesquisa

A

gid

codigo

latitude

longitude
< > r

v W Carregar valores  todos os valores Unicos | | 10 amostras

Pré-visualizagdo da saida: 1

Cancelar

Figura 9 — Filtro avancado na tabela de atributos.

A tabela de atributos passa a mostrar apenas as ocorréncias com velocidades abaixo dos
0.5 nés, permitindo ver quais 0s navios correspondentes na coluna codigo.

8.4 Feche a tabela de atributos e grave o projeto.

90






Exercicio 6

INTRODUCAO AO
GEOPROCESSAMENTO AUTOMATICO

Objetivos

Este exercicio tem como objetivo apresentar uma introducdo ao geo-
processamento automatico.

Pretende-se que o utilizador crie um modelo que corra automaticamente
uma sequéncia de tarefas de selec@o, repetindo-se, neste exemplo, o pro-

cessamento realizado no exercicio anterior, em que se selecionam os navios
que permane¢am determinado tempo dentro de uma area com algum tipo de
restricao.

No final deste exercicio, o modelo criado devera processar automaticamente
diferentes passos, possibilitando ao utilizador escolher diferentes areas de
restricdo e a condicdo de velocidade.

A. ABRIR UM PROJETO ARCMAP E ADICIONAR CAMADAS DE
DADOS

1. Abra um novo projeto QGIS e adicione os dados com as posi¢cdes de
navios utilizados no ultimo exercicio.

2. Adicione as areas marinhas protegidas: Madeira Tore, Nazaré, Espichel
e S. Vicente.

a\)é

2.1 Em Adicionar camada vetorial va a Pesquisar.
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2.2 Para tornar mais facil a pesquisa de ficheiros em formato shapefile, na
janela Abrir uma camada vetorial OGR suportada, escolha mostrar
“ESRI Shapefiles” em vez de “Todos os ficheiros”.

3. Caso alguma das camadas esteja num SRC diferente das restantes,
grave-a com o0 mesmo SRC das restantes camadas.

B. CRIARMODELO DE PROCESSAMENTO AUTOMATICO

4. Abra o Modelador de Processamento (Menu Processamento
» Modelador Grafico) (Figura 1).

B R = B &

~ Pardmetros [Introduza o nome do medelo... ” [Introduza o nome do grupo ...

Boolean ~
Extent

File
Mumber
Raster layer

b o o o o

String

gF Table

gF Table field
aF Vector layer

Entradas Algoritmos < }

Figura 1 - Janela de constru¢cdo do modelo de geoprocessamento automatico.

5. Adicione a primeira acdo ao modelo.
Pretende-se, nesta primeira acéo, criar uma nova camada de dados que contenha apenas os pontos

(posicdes de navios) que se incluem na Area Marinha Protegida (AMP) da Nazaré (& semelhanca

do que fez no Exercicio 5). B Defiriicio do parmet 5 %
X INIGao do paramewro H

5.1 Defina os dois elementos iniciais no
menu Entradas. Mome do parametro | PosicoesMaviog| |

1.1.1 Escolha Vector layer para
adicionar (arrastando ou clicando duas vezes) Tipo de Shape Ponto -
uma nova entrada no modelador e defina o
nome que sera apresentado (PosicoesNavios).
Exigido Sim -
1.1.2 Repita para a entrada AMP
(Tipo de Shape: Poligono).

Cancelr
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5.2 Defina a ferramenta a utilizar para cortar a camada com as posi¢des dos
navios, de forma a que se inclua na camada AMP Nazaré.

5.2.1 Escolha, no separador Algoritmos (em baixo, a esquerda), Geoalgoritmos »
Ferramentas de sobreposicao vectorial » Intersec¢dao (arrastando ou
clicando duas vezes neste Ultimo) e defina o elemento a cortar
(PosicoesNavios), o elemento de corte (AMP) e o nome da camada a gravar
com o resultado (NaviosAMP), escolhendo a mesma pasta dos dados (Figura
2).

A aplicacdo QGIS, sendo open-source, esta constantemente a ser atualizada
pelos voluntérios que nela trabalham, o que significa que dependendo das

o versbes e das atualizagbes realizadas o caminho possa variar.
Recomendando-se, assim, que se faca uma pesquisa por termos (em
portugués ou inglés), quando ela esteja disponivel.

‘2 Modelador de Processamento

B H =" : i

inters @ || [Maviosamp |[Exercs

v 7 Geoalgoritmos QGIS
~ Ferramentas de sobreposicdo vectorial

m| >

[®' Intersecgdo
» Intersecgdes de Linha
v & SAGA(2.1.2)
~ Raster calculus
& Fuzzy intersection (and)
~ Vector line tools

9F PosicoesNavios

3

In
™' Intersection »
& Line-polygon intersection &
v Vector polygon tools a9F AMP Out ~E|
& Intersetar Intersecgdo *— ™% NaviosAMP

38

@- Polygon-line intersection

Entradas | Algoritmos < m >

Figura 2 — Escolha do algoritmo para a primeira agdo do modelo.

522 Vaa i (Correr modelo) e defina as camadas correspondentes a cada
elemento do modelo.

6. Grave o modelo de processamento automaético.

6.1 Preencha o nome do modelo (NaviosAMP) e o nome do grupo (e.g.
Exerc6).

6.2 Faca Guardar como H na pasta sugerida pela aplicagdo (...»
processing » models), escolhendo o nome NaviosAMP para o modelo
criado.
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A partir de agora, sempre que abrir o Modelador Grafico
do QGIS (no menu Processamento), poderda abrir o

modelo guardado em .

Este modelo passa também a aparecer na lista de modelos
na janela de Ferramentas de Processamento. Aqui basta
um duplo clique para fazer correr o modelo (permitindo
sempre escolher quais as camadas a utilizar em cada

entrada do modelo); para o editar, faca BLDR » Editar
modelo.

Ferramentas de Processamento

Pesquisar...

> Algoritmos utilizados recentemente
» -y Comandos GRASS GIS 7 [314 geoalgoritmos]
> 3 GDAL/OGR [48 geoalgaritmos]
> ¥ Geoalgoritmos QGIS [111 geoalgoritmos]
> LWGEOM algorithms [2 geoalgoritmos]
v iﬁ Modelos [1 geoalgoritmos]
' Exerch

iﬁ MNaviosAMP
¥ Tools

o Add model from file

@ Create new model

iﬁ Get models from on-ine scripts collection
> (S SAGA (2.1.2) [235 geoalgoritmos]
> |E Scripts [0 geoalgoritmos]

O QGIS permite também gravar o modelo como um script Python no botao % .

No caso de a nova camada ndo ter sido automaticamente carregada, carregue-a em

(Figura 3).

Adicionar Camada Vetorial

Figura 3 — Resultado da primeira agcdo executada no modelo (corte da camada das posi¢cdes dos navios com o

poligono da AMP Nazaré).

7. Teste o novo modelo com diferentes AMP’s.

7.1 Devera substituir os parametros a preencher, de “Nazaré” para cada uma
das diferentes AMP’s. Grave os resultados com nomes diferentes para

cada AMP.
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8. Adicione uma nova acdo ao modelo, que permita extrair as

embarcacdes que naveguem a velocidade inferior a 0.5 nos.

O campo com as velocidades das embarcacbes € o campo “v”.

8.1

8.2

8.3

8.4

8.5

8.6

Abra 0 modelo criado e, no separador Algoritmos, escreva, na pesquisa,
“‘extract’. Escolha a Ferramenta vectorial de seleccao “Extrair por
atributo” (Extract by atribute), arrastando-a para o modelo.

Como camada de entrada escolha “Intersec¢cgo’ a partir do algoritmo
‘Intersection’.

Como Atributo de selecgao escolha “v”’, Operador “<” e Valor “0.5”.

Para OutputVector escolha NaviosAMP_vO05.

Escolha para Algoritmo de Origem “Intersection’ (Figura 4).

Faca correr o modelo, selecionando os parametros corretos e guardando

o novo modelo na pasta do exercicio 6, com o0 nome
NaviosAMPNazare v05 (Figura 5).

Parametros Help

Descricdio |Extract by attribute |

Camada de Entrada

|'Inhersecg?o' a partir do algoritmo 'Intersection’ . |

Atributo de seleccdo

[v

‘@ Multipla selegio

Operador
< Intersection | | Selecdonar tudo -
Valor - -
Lo
Extraido (atributo) <Outputvector =
[NaviosaMP_v0s o ]
Algoritmos de Origem Cancelar

1 elementos selecdonados l:l

| oK || Cancelar |

Figura 4 — Preenchimento dos parametros da ferramenta de extragdo por atributos.
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@ Modelador de Processamento

EEHR W Z]8

extract NaviosAMP ” Exercg

~ Vector (v.%) -~ o _ _ 3|
PosicoesNavios
< v.extract - Selects vector objects fr...

v b GDAL/OGR
~ [GDAL] Projecgdes In
@& Edrair projecio
~ # Geoalgeritmos QGIS ] ™' Intersection 3|
=)

* Ferramentas vectoriais de selecgdo

X - ; <= AMP z‘ Out
& Extraccdo aleatoria | Intersecgdo In

.V.' Extraccdo aleatoria dentro de sub... -
| Z Exrair por atributo B

Z Extrair por localizagio

~ Ferramentas vectorias de geometria Out

/" Extrair Nos

|¢ NaviosAMP | |-?' Extract by attribute $|

™ ‘* NaviosAMPNazare_v05 |
v

Entradas | Algoritmos < m >

Figura 5 - Escolha do algoritmo para a segunda agédo do modelo.

O resultado apresenta agora apenas o0s navios na AMP da Nazaré com velocidade inferior
a 0.5 nés (Figura 6).

Painel de Pesquisar
LRETHO
& postels
# spatialite
Q_.':' ArcGisFeatureServer
@ ArcGisMapServer

0 ows

& wes

& wrs

& wMs
<| [ |
Painel das Camadas

o« @l @ TV &-F A0

1 Il AMP12 Madeira Tore

Figura 6 - Resultado da segunda acdo executada no modelo (sele¢do dos navios na AMP da Nazaré com velocidades
inferiores a 0.5 nés).

9. Corra o0 modelo para diferentes areas de restricdo e com diferentes
critérios de velocidade.

9.1 Substitua, no modelo, cada uma das camadas referentes a cada area de
restricdo e altere o valor a atribuir a ‘v’ (Figura 7).

9.1.1 Porque é que a AMP da Madeira ndo mostra resultados de posi¢cdes de navios
abaixo dos 0.5 nés de velocidade? (Veja as tabelas de atributos de cada
camada, com e sem a extracao por velocidade).
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@ ArcGisMapServer
) ows
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& wms

< | n |

\Painel das Camadas

o l® T -BEL
[ © MNaviosAMPNazare_v05
® NaviosAMPNazare
E . Amphazare
[ © MaviosAMPEspichel_v05
[+ ® MaviosAMPEspichel
. ampl4_espichel
[+ © MaviosAMPSVicente_v05
[+ ® HaviosAMPSVicente
1 [l amp15_svicente
o MaviosAMPMadeira_v05
v ® MaviosAMPMadeira
! [l AMP12_Madeira_Tore
Wl © Havios

Figura 7 — Resultados do modelo para as diferentes AMP’s, para a velocidade 0.5 nés.
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Exercicio 7
PUBLICA(;AO DE MAPAS NA INTERNET

Objetivos

Neste exercicio ira efetuar a disponibilizacdo de dados na internet através
de um servigo de mapas utilizando uma Infra-Estrutura de Dados Espaciais
(IDE).

A. ABRIRUMPROJETO QGISUTILIZADO ANTERIORMENTE

1. Abraum dos projetos QGIS criados em exercicios anteriores.

1.1 Remova as camadas de dados no modelo matricial (apenas iremos
publicar dados vetoriais) e simplifique ao maximo o seu projeto (i.e. remova
todas as camadas auxiliares que estédo inativas), mantendo apenas as
camadas de dados que quer publicar.

1.2 Verifique se tem instalado o médulo OpenLayers. Caso ndo tenha, instale-
0.

1.2.1 Carregue umaimagem de base a partir do modulo OpenLayers, e.g. 0 Gooogle
Maps Satellite (Web » OpenLayers plugin » Google Maps » Google Satellite).

B.ADICIONAR UMA INFRA-ESTRUTURA DE DADOS
ESPACIAIS (IDE)

2. Adicione um Mdédulo com capacidade para publicacdo de Servicos de
Dados Espaciais.
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2.1 Entre em Modulos » Gerir e instalar Médulos e pesquise por QGIS
Cloud Plugin. Instale este modulo.

3. Abra o modulo QGIS Cloud e registe-se. sgars coud 8 x

3.1 Aceda ao icone recém-criado s . Abre-  Msp  Upbadbata  Account  About
se automaticamente uma janela no canto  server: |hetps:/japi.qgiscioud.com A
inferior esquerdo.

Login Signup
A janela do moédulo QGIS Cloud tem um separador  [.ipases
Map que permite publicar os mapas; tem um
separador Upload Data para confirmar os ficheiros que
serdo enviados para o servidor; e um menu Account
para fazer login no QGIS Cloud.

Create Delete Refresh

3.2 Entre no menu Account, onde |he seré pedido para fazer login.

3.3 Abra um browser para criar uma nova conta, em https://agiscloud.com/.

3.4 Faca agora login no menu Account do médulo QGIS Cloud, dentro do
QGIS Desktop.

C. PARTILHAR OPROJETO QGIS

4. Faca Upload Data dos ficheiros a enviar, na janela do QGIS Cloud (o
servigo gratuito do QGIS Cloud permite fazer upload de até 50 MB de
dados).

4.1 Crie uma nova base de dados, no separador Account.

4.2 Mude para o separador Upload Data e selecione, em Database, a base
de dados que acabou de criar. Faca Upload data.

4.3 No separador Map faca Publish Map.

4.4 Grave novamente as alteracdes ao projeto, caso ndo o tenha feito
anteriormente.
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D.UTILIZAR O SERVICO QUE PUBLICOU ATRAVES DA
INTERNET

5. Abra o projeto que criou, clicando no link Webmap criado pelo médulo
(e.g. http://ggiscloud.com/amorix/AE_Ex3web). O projeto sera
automaticamente carregado numa pagina do QGIS Cloud no browser
gue utiliza por defeito no seu computador.

5.1 Entrando na sua conta, no website QGIS Cloud, é possivel descarregar o
projeto QGIS.

6. Copie o link da linha seguinte, na janela do QGIS Cloud no QGIS
Desktop (Mobile map) para o browser do seu smartphone, para
visualizar o projeto em versao mobile.

7. Partilhe o endere¢co dos servigos que criou com 0S seus colegas e
visualize os servicos disponibilizados por eles.
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